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About This Release 
This document describes enhancements in ERDAS IMAGINE 2020 Update 2 (v16.6.2), including IMAGINE 
Photogrammetry (formerly LPS Core) and ERDAS ER Mapper. Although the information in this document is 
current as of the product release, see the Hexagon Geospatial Support website for the most current version.  

Update 2 includes both enhancements and fixes. For information on fixes that were made to ERDAS 
IMAGINE, see the Issues Resolved section. 

This document is only an overview and does not provide all the details about the product's capabilities. See 
the online help and other documents provided with ERDAS IMAGINE for more information. 

Development of ERDAS IMAGINE 2020 focused on ensuring that virtually all aspects of ERDAS IMAGINE run 
in 64-bit. Consequently, the installer has been split into three separate installers: ERDAS IMAGINE 2020 64-
bit; ERDAS IMAGINE 2020 32-bit; and ERDAS ER Mapper 2020. The same split is available for Update 2 
installers. 

ERDAS IMAGINE Product Tiers 
ERDAS IMAGINE performs advanced remote sensing analysis and spatial modeling to create new 
information. In addition, with ERDAS IMAGINE, you can visualize results in 2D, 3D, or video and on 
cartographic-quality map compositions. The core of the ERDAS IMAGINE product suite is engineered to scale 
with your geospatial data production needs. Optional modules (add-ons) providing specialized functionalities 
are available to enhance your productivity and capabilities. 

IMAGINE Essentials is the entry-level image processing product for map creation and simple feature collection 
tools. IMAGINE Essentials enables serial batch processing. 

IMAGINE Advantage enables advanced spectral processing, image registration, mosaicking and image 
analysis, and change detection capabilities. IMAGINE Advantage enables parallel batch processing for 
accelerated output. 

IMAGINE Professional includes a production toolset for advanced spectral, hyperspectral, and radar 
processing and spatial modeling. This tier comes standard with ERDAS ER Mapper. 

IMAGINE Photogrammetry maximizes productivity with state-of-the-art photogrammetric satellite and aerial 
image processing algorithms. 
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New Platforms 

Full Installers 

Starting with ERDAS IMAGINE 2020 Update 1, update installers became full installers. 

This means that they can either be installed as a stand-alone (install ERDAS IMAGINE 2020 Update 2 without 
first installing ERDAS IMAGINE 2020) or as an update to an existing install (installing ERDAS IMAGINE 2020 
Update 2, even if ERDAS IMAGINE 2020 Update 1 is already installed, will update the existing installation to 
v16.6.2). 

With full installers, it is no longer possible to roll back an update to the previous version. So, for example, if 
ERDAS IMAGINE 2020 were updated with ERDAS IMAGINE 2020 Update 2, uninstalling it removes ERDAS 
IMAGINE 2020 entirely. Consequently, “rolling back” now involves uninstalling ERDAS IMAGINE and re-
installing the desired previous version. 

ArcGIS 10.7.x and ArcGIS 10.8.x 

ERDAS IMAGINE 2020 Update 2 (32-bit) has been tested and declared supported when using an installed 
and licensed version of ArcGIS 10.6, 10.6.1, 10.7, 10.7.1, 10.8, or 10.8.1 to provide geodatabase support 
libraries.  

Alternatively, the IMAGINE Geodatabase Support component (based on ArcGIS Engine 10.7) can be installed 
to provide geodatabase support. 

 

Licensing 

ERDAS IMAGINE 2020 installers no longer attempt to automatically install geospatial licensing tools as part of 
the installer. If customers wish to use geospatial licensing tools (for example, to set up a floating/concurrent 
license server), Geospatial Licensing 2020 must be downloaded separately. 

It is strongly recommended that customers upgrade to the newest version of Geospatial Licensing 2020. If in 
doubt, refer to the Microsoft Windows Add or Remove Programs utility to determine the version currently 
installed. 

The appropriate download can be found in the Downloads section of the Hexagon Geospatial web site. 

 

  

https://download.hexagongeospatial.com/search?lang=en&product=b3b4786d3d4742ae8d1e7aeee50dae69
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New Technology 

IMAGINE DSM Extractor module 

The new IMAGINE DSM Extractor features advanced SGM (Semi-Global Matching) algorithms for faster and 
denser digital surface generation from stereo imagery. This module replaces the existing XPro SGM and 
Tridicon SGM modules. You can now generate denser point clouds in a fraction of the time with enhanced 
accuracy. IMAGINE DSM Extractor works with all types of imagery, sensor data, and file formats that are 
supported by IMAGINE Photogrammetry with none of the former limitations on file size. 

 

Figure: A point cloud extracted from an UltraCam Eagle Mark 3 camera displayed as a surface. 

Benefits of the new IMAGINE DSM Extractor module include: 

• Support for all sensors supported by IMAGINE Photogrammetry 

• Support for all imagery formats and bit depths supported by IMAGINE Photogrammetry 

• On-the-fly epipolar resampling, removing the need to generate epipolar resampled images 

• Support for batch or local/distributed parallel processing 

• Generates Intensity, RGB, and RGBN encoded point cloud files 
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Figure: A point cloud extracted from DigitalGlobe WorldView-3 imagery displayed as a surface. 
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New Operators for Spatial Modeler  

Hexagon continues to add operators to Spatial Modeler. New (or modified) operators are outlined below, with 
a brief description of their capabilities. See the ERDAS IMAGINE 2020 Help for the full details of each 
operator, and visit the Hexagon Geospatial Community Spatial Recipes page for examples of spatial models 
that use many of these capabilities. 

Associate Georeference  

 

Replaces the georeference associated with the input geospatial data, GeospatialDataIn (currently limited to 
IMAGINE.Raster), with the input georeferencing. Common use cases involving this operator are described in 
the Raster Geometry in Spatial Modeler section below and may also utilize other new operators listed below.  

CRS ID Output 

 

This operator outputs a coordinate reference system represented by the input CRS ID to a file in one of the 
following supported file formats: 

• ERDAS IMAGINE Projection Library (PLB) 

• GeoMedia Coordinate System File (CSF) 

• ERDAS IMAGINE World Coordinate System (WCS) 

• ESRI Projection File (PRJ) 

Classify Vegetation 

 

This operator identifies points from the input point cloud that represent vegetation and reassigns them to either 
Low Vegetation (Class 3), Medium Vegetation (Class 4), or High Vegetation (Class 5). 

To discriminate between Low, Medium, and High Vegetation classes, the operator expects that the points that 
fall on the ground in the point cloud have already been classified, that is, assigned to the Ground class (Class 
2). If the ground points in the input point cloud are not classified, you can classify them using the Classify 
Ground operator. 

https://community.hexagongeospatial.com/t5/Spatial-Recipes/tkb-p/KS_SpatialModeler_AnalyticalRecipes
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The classification is performed by first analyzing the geometric relationship of the non-ground points to their 
neighbors. Several geometric descriptors (scatter, planarity, linearity, and verticality) are computed for the 
points and then taken into account in determining possible vegetation points. If the radiometric properties Near 
Infrared and/or Red, Green, and Blue (RGBN or RGB) are supported by the point cloud point record format, 
these properties are used to determine which candidates represent vegetation points. 

If the point cloud has color (RGB/RGBN) attributes, each point's vegetation index is computed and compared 
against the value specified on port VegetationIndex. For point clouds with RGBN attributes, the Normalized 
Vegetation Difference Index (NDVI) is used. For those with RGB attributes, the Greenness index is used. 

If a point's vegetation index is greater than or equal to the value specified on port VegetationIndex, it is 
considered a candidate for classification as vegetation. 

Compute Footprint  

 

This operator generates the not-necessarily-rectangular footprint for raster data. The output Footprint is the 
outline polygon that defines the extent/boundary of the input Raster's valid (non-NoData, as determined by 
mask or supplied background values) area. 

 

Alternatively, a spatial model like the one below could be used to set “outside the footprint” to value-based 
NoData (e.g. 0) while converting “inside the footprint” pixels that were that value to a value of 1 to avoid them 
also being treated as NoData “holes”. 
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Input Pan data with undifferentiated pixels with a DN of 0 causing “holes” (shown by red background color):

 

Spatial Model using the new Compute Footprint operator: 

 

Resulting output image with trimmed NoData “surround” and no interior holes 
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Convert To Point Cloud  

 

This operator converts features to point cloud. 

The input features’ primary geometry field's CRS determines the dimensionality of the geometries, which may 
be either a 2D or 3D CRS. If the primary geometry field's CRS is 2D, the output point cloud’s vertical CRS will 
be 1D unknown. If feature geometries are linear or area, the vertices are used to define the point cloud points. 

If the features’ primary geometry field’s CRS is 2D, the input features must have an attribute named 
ELEVATION of data type IMAGINE.Float or IMAGINE.Double, which provides the Z value. 

The operator determines the point record format based on the attributes of the input features. 
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Create Affine Conversion  

 

This operator creates an affine conversion based on input affine coefficients and source CRS. The target CRS 
(the To property of the resulting CoordinateOperation) does not need to be specified and will be created as a 
GridCRS (a derived CRS) , which is derived from the SourceCRS using the provided affine conversion. 

Note that the meaning of the Invert input differs from the Create Affine Transform operator. In this Create 
Affine Conversion operator, setting Invert to true results in the inversion of the math transform implied by the 
Coefficients, but the To of the resulting CoordinateOperation remains the GridCRS defined by that inverted 
conversion. This is useful for defining Georeferencing because for rectified images it is more natural to specify 
the upper left map coordinate and cell size (implying a pixel-to-map conversion), but the proper form of the 
Georeferencing CoordinateOperation is as a map-to-pixel conversion. 

Common use cases involving this operator are described in Raster Geometry in Spatial Modeler section 
below. 

Create Directory  

 

This operator creates a specified directory, including any parent directories that do not exist. If the directory 
already exists on the file system, the operator will simply output the directory name. The operator will fail if the 
specified directory cannot be created. 

Define Training Augmentation Parameters  

 

This operator creates a set of parameters that will be used for generating additional training data from existing 
training data. 

Depending on the selected options, parameters for dynamically generating scaled, rotated, flipped, cropped 
and radiometrically adjusted versions of the existing training data can be specified. Augmenting existing 
training helps improve object detection accuracy. 

The parameters can be used as an input in the Initialize Object Detection operator to generate additional 
training data during the initialization process. 
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Delete File  

 

Deletes a file. For example, if c:\temp\foo.txt is provided as input, that file will be deleted from the file system. If 
the file does not exist on the file system, the operator will simply output the filename. The operator fails if the 
specified file cannot be deleted. 

Dictionary Input  

 

Read HDR files and other text files, such as DiMAP XML headers containing key/value pairs, and turn them 
into dictionaries for use within a spatial model. 

Redefine Grid 

 

Redefine Grid allows a raster's grid geometry to accommodate alignment to map axes, pixel size scaling, and 
translation of the grid boundary's minimum to 0, 0. The input boundary is expected to be a GridBoundary (that 
is, the CRS property of the Boundary has a value that represents a GridCRS). The redefinition accommodates 
the modification of properties of typical concern, that is, orientation/rotation, scaling, and translation, while 
maintaining proper georeferencing for the newly defined grid. 

With respect to orientation, the grid will, by default, be redefined such that the new grid axes are parallel to the 
axes of TargetCRS (or, if not specified, the CRS to which the original grid is referenced). This may involve 
orienting the grid through an inverse ground to image transformation (for calibrated grids) or eliminating any 
rotational element that might be present in a rectified grid. 

The scale of the grid may be specified through an X and Y cellsize. If these are not specified, the cell size 
used will be that calculated by the default behavior of the Calculate Cell Size operator when BoundaryIn is 
supplied as the Grid input and TargetCRS is supplied as the TargetCRS input. 
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Finally, by default, the new grid will be adjusted such that the minimum coordinate of its boundary is 0,0. If this 
option is not taken, the output grid boundary limits will still be set such that the entire input grid boundary can 
be represented in the output grid. This may require negative grid coordinates. 

Normally, AlignToReferencedAxes is specified with a default value of true and BoundaryOut is used with the 
Warp operator to warp a raster input to the redefined grid geometry. A value of false, however, allows 
redefinition of a grid that may be used effectively as a reprojection to the (presumably new) TargetCRS and 
saved as a calibration when BoundaryOut is supplied to Update Georeferencing instead of Warp. 

Common use cases involving this operator are described in Raster Geometry in Spatial Modeler section 
below. 

Remove Overlapping Detections 

 

During object detection using the Detect Objects Using Deep Learning operator, the operator may find multiple 
bounding boxes for the same object. 

This operator detects if there are two or more bounding boxes that overlap by more than 
DetectionOverlapAllowance, and, if so, it will retain the bounding box that has the highest probability and 
remove all the others. 

As part of the non-maximal suppression algorithm used to remove overlaps, the overlap between two 
bounding boxes is determined by computing their Intersection over Union (IoU). IoU is defined as the ratio of 
the intersection area to the union area of two bounding boxes. 
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Updated Operators 

Cat 

The Concatenate (Cat) operator is now expandable, and will also accept lists of input strings, enabling more 
than two inputs to be evaluated in a single operator. 

This means you can replace a spatial model that looks like this… 

 

 

…with a much simpler one that looks like this. 
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Clump 

 

The Clump operator (which re-organizes thematic raster data into groups of contiguous pixels with the same 
original class/DN value) has been re-written to address several issues, primarily to improve the performance 
through a new multi-threaded tile-based approach and to output unsigned 32-bit data by default. 

Note: The behavior of this new Clump operator is different from the prior Clump in that the new operator 
clumps all pixels that are not NoData, so even 0s will form clumps. Consequently, if you are replacing the old 
(deprecated) operator in an existing spatial model with the new operator, be aware that the result may now 
differ. You may need to add a Set to NoData prior to the new Clump to ensure that the same set of pixels are 
clumped. 

Convert To Features 

 

The Convert To Features operator has been updated to accept point clouds as input for conversion to (point) 
features geometries. Previously, it was primarily intended to convert raster. 

IMAGINE.PointCloud is converted to features having 3D point geometry and attributes based on the schema 
defined by its point data record format (see LAS Specification 1.4). An additional attribute, ELEVATION, of 
type IMAGINE.Double, holds a copy of the Z value from the 3D point geometry. 

This new Convert To Features operator has also been used to implement a new Spatial Modeler-based Raster 
to Shapefile utility on the main ribbon Vector tab.  

Attribute information can also be converted to features for further analysis (features do not necessarily need to 
contain a geometry attribute field). For example, in the model shown below, the histogram of a floating-point 
raster image (not the pixels themselves) is passed through the Convert To Features operator for analysis of 
the values. The Convert To Features operator also tries to preserve any bin functions that would be present on 
the input data, such as would be used for float raster values. The model identifies the Majority set of DN 
values represented in the binned histogram data (by sorting the histogram in ascending order and identifying 
the index location of the highest histogram value) and returns the minimum and maximum values of that bin (in 
this case, the input image had the most pixel values falling in the 0.361339 to 0.361369 bin). 
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Create Column(s) 

 

The Create Columns(s) operator has been updated to accept Lists as input. 

Enhance Contrast Using CLAHE  

 

Previewing the results of this operator will now correctly process just the extent and scale displayed in the 
Preview window, thereby providing much faster visual feedback. 
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Get ECW Options 

 

A new port called ColorSpace has been added. It had previously been noted that on creation of a three-band 
ECW image, the assumption was that the three bands represented RGB (truecolor) color space, and 
compression optimizations were consequently applied based on this assumption. However, this is not 
necessarily true — the three bands might, for example, be three bands derived from SAR data, and the colors 
produced by these three bands do not represent “truecolor.”  

Consequently, the ColorSpace port has been added to control this behavior. Four options are provided: Auto, 
Greyscale, RGB, and Multiband. The ECW compressor uses source color space description to determine the 
optimal color space for compression. Currently, only the RGB option will use an alternate color space (YCbCr) 
to improve the compression efficiency for three-band RGB imagery. Note that using the RGB option for non-
RGB three-band imagery can produce undesirable compression results due to the assumptions built into the 
RGB-to-YCbCr conversion equation. 

If Auto is selected, then if Raster has one band, ColorSpace is set to Greyscale; otherwise, Multiband is used. 

The color of the NoData mask in an output ECW file can now also be controlled and set to Black or White. 
This capability is available for general ERDAS IMAGINE via a Preference.  

Get Geometric Model Info 

 

GridBoundary is being promoted as the definitive way to represent raster geometry in Spatial Modeler. As 
such, the Georeferencing operation to be examined by the Get Geometric Model Info operator can now be 
presented as either a GridBoundary or a GridCRS. 

Initialize CART Regressor and Initialize Random Forest Regressor 

 

Both of these operators required that the list of Dependent Attribute variables be manually entered, which was 
time-consuming and prone to error. They have been updated to provide a graphical user interface, which 
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enables the user to select the appropriate attribute fields from a list of those available from the provided 
TrainingData. 

 

Initialize Object Detection 

 

Previously, Object Detection could have issues trying to identify smaller features, such as cars, as opposed to 
aircraft. Consequently, the operator has been enhanced to better handle smaller features, as shown by the 
detection example below. 
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Logical And and Logical Or 

 

 

These two operators are now expandable and will also accept Lists of inputs, enabling more than two inputs to 
be evaluated in a single operator.  
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Point Cloud Information 

 

The Point Cloud Information operator has been updated with Boolean ports to force the computation of the 
point count and boundary of the point cloud being passed through. This ensures accuracy of these values for 
point clouds, which may have been manipulated by upstream processes.  

Raster Output 

 

A new Statistics input port has been added to Raster Output. This was added because of a need to set custom 
statistics on an output. It allows statistics created using an AOI, skip factor, ignore value(s), etc., to be passed 
in. 

A new Format input port has also been added to define the format to be created rather than leaving it as a 
decision made based on the filename extension provided.  
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Read Sensor Metadata 

 

Read Sensor Metadata has been updated to reflect that it will read metadata from various flavors of 
DigitalGlobe/Maxar WorldView sensors, not just GeoEye-1.  

Simplify Geometry 

 

A ShrinkOnly port has been added. This port is applicable only to AreaGeometry features. If it is true, the 
simplified geometries are guaranteed to be wholly inside the original geometries.  

For example, in the following two graphs, the green polygons are input geometries and the red polygons are 
the simplified results. The left graph shows the result with ShrinkOnly being true. The right one shows the 
result with ShrinkOnly being false. 
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Various Math Operators Updated to Accept Lists 

 

Various math operators have also been updated to accept Lists as input to make interaction with Iterator 
outputs easier. 

Raster Geometry in Spatial Modeler 

Introduction 

The Spatial Modeler strives to make processing tasks easy to assemble and efficient to execute. One of the 
main ways it attempts to ease the model creator's efforts is by making data conversion automatic so that 
sensible operations can succeed even in the face of a variety of data representations. 

For processing tasks that are geospatial, this data conversion typically needs to involve coordinate operations, 
i.e., representing coordinates for two or more data sources in the same coordinate reference system (CRS), 
so that data that represents the same place can be recognized. 

For geospatial data with explicit geometry, such as Features and PointCloud, coordinate operations are 
familiar and intuitive to most users. Operations on geospatial data with implicit geometry, i.e., Raster, tend to 
be more awkward. Spatial Modeler's simplified representation of Raster geometry, the Grid Boundary, 
attempts to make these operations easier to comprehend and undertake while continuing to fully subscribe to 
international definitions and standards. 

Geometry Transformation vs. Georeferencing Correction 

Regardless of the type of geospatial data (Features, PointCloud, Raster), it is important to understand the 
distinction between geometry transformation and correction of a dataset's georeferencing information. 

In geometry transformation, the geospatial data's georeferencing information is assumed to be correct and this 
information is used to facilitate the rereferencing of explicit or implicit coordinate values to a different 
coordinate reference system. This can be accomplished using operators such as Coordinate Transformation, 
Elevation Transform, Point Cloud Reproject, and Warp. 

In georeferencing correction, on the other hand, the geospatial data's georeferencing information is assumed 
to be incomplete or in error. The intention is not to modify explicit or implicit coordinate values, but rather to 
revise how those values are to be interpreted (which, in the case of a Raster's grid coordinates, may involve 
changing the way they are related to an external coordinate reference system). To effect these changes, 
operators such as Associate Georeference and Attach Vertical CRS may be used. Some of the more 
challenging cases of Raster correction may require the preparation of input to Associate Georeference via 
operators like Redefine Grid, Create Affine Conversion, and Associate Elevation. 
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Typical Use Cases 

The following typical use cases illustrate how Raster geometry can be manipulated using the Grid Boundary 
and related representations: 

CRS Association 

A Raster Input has an associated world file but no identified CRS. How might a CRS definition be associated 
with the Raster for reliable integration with other data in a spatial model? 

A model such as the following may be used to achieve this result. 

 

By setting the Input property of the CoordinateReferenceSystemID Input operator to the desired CRS, either 
via direct input such as: 

 

or by interacting with the UI Provider (CRS chooser), the georeferencing operation from the associated world 
file which is ingested by Raster Input will be retained when the CRS definition is associated in the Associate 
Georeference operator, whose output will have the desired georeferencing. The original input may be 
persistently updated by using the Update Georeferencing operator as shown. If the data format is such that it 
can retain the georeferencing, such as IMG or TIF, the georeferencing in its entirety will be placed in the 
dataset, rendering the world file no longer necessary. 

Georeferencing 

The upper left corner coordinate in a known CRS and the cell size of an unreferenced image are known. How 
might this information be associated with the Raster for reliable integration with other data in a spatial model? 

This case is similar to the CRS Association case, but we will require the Create Affine Conversion operator to 
relate our Raster to the known CRS directly with the known georeferencing parameters. The model below 
illustrates this approach: 
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Note that the Invert parameter of Create Affine Conversion is set to true, indicating that we are providing pixel-
to-map parameters to Compute Affine Coefficients which must be inverted to supply the correct map-to-pixel 
operation to Associate Georeference. 

As with the previous case, the input dataset may be directly updated with the Update Georeferencing operator. 
In fact, the output of Create Affine Conversion may be sent directly to Update Georeferencing if there is no 
requirement to update the input on-the-fly within the model using Associate Georeferencing. 

Linear Transformation 

Raster data requires reflection in order to make it consumable by a less capable GIS tool that is confused by 
the current form of its georeferencing. How are grid-space transformations that preserve georeferencing 
performed? 

The model below performs a vertical flip of the image pixels while preserving the georeferencing of the original 
image. Since we want to preserve the original georeferencing, it is necessary to Warp the input pixels to the 
newly defined raster geometry prior to saving them to a different dataset. 

 

Note that to flip vertically, the image must be translated and scaled. The correct translation is height - 1 so that 
the center of the bottom-most, left-most pixel is at the origin prior to flipping the y-axis with a scale of -1. 
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The raster geometry is manipulated with the Linearly Transform Georeferenced Image sub-model shown 
below: 

 

An affine conversion from the original GridCRS using the vertical flip coefficients produces an operation to a 
new GridCRS. This new GridCRS can be taken from that operation and used to redefine the input grid. 
Supplying a Grid Boundary to Warp is the only way to directly define the output Grid Boundary that we desire. 
Providing the output of Create Affine Conversion directly to Warp will not produce the desired result. 

Reprojection 

How can georeferenced Raster data be explicitly re-referenced to a different external coordinate reference 
system? 

The tricky part of this operation is usually deciding on the output cell size. Redefine Grid will use the default of 
Calculate Cell Size when provided with no inputs on its XCellSize, etc., ports as shown in the model below. 
This behavior can easily be controlled more finely by using Calculate Cell Size explicitly in the model and 
supplying its outputs to Redefine Grid. 

 

Using Associate Georeference and Update Georeferencing instead of Warp and Raster Output will allow a 
reprojection calibration to be placed into the original dataset's georeferencing information. 
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Rectification 

Referenceable imagery requires rectification, again, so that it might be consumed by a less capable GIS tool 
that cannot access the sensor model information associated with the imagery. What is the approach to that in 
a spatial model? 

The model below illustrates using Redefine Grid to orient a referenceable grid to the external coordinate 
reference system to which it is referenced (this is the default behavior of the operator when no TargetCRS is 
supplied). A DEM input may be supplied to ensure high quality ground-to-image transformation. As shown, 
Redefine Grid will utilize the Calculate Cell Size default internally, but finer control is possible by using 
Calculate Cell Size explicitly in the model. 

 

Tile Requests in Arbitrary Grid Geometry 

A spatial model can support tile delivery of a geoprocessing imagery server, delivering tiles in any supported 
CRS of interest. What is a recommended way of approaching the geometry manipulation aspects of such a 
model? 

One possible way to approach this use case is to create a model that is prepared to deliver requested tiles for 
a given Raster Input based on a specified Target CRS ID. Failure to supply a Target CRS ID indicates a desire 
to request tiles in Raster Input's pixel coordinates. A tile request server caching model execution based on 
Raster Input, Target CRS ID, can direct a request to the proper model. The Warp operator can handle 
requests of arbitrary scale when properly formulated. This can be readily constructed using an extent in Target 
CRS ID and an associated tile size. 

 

For a glossary of terms mentioned in this section (e.g. “CRS”), see the Help for Spatial Modeler.  
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Spatial Model Editor Interface Improvements 

Copying and pasting operators from one Spatial Model to another is now independent of the relative zoom 
scales of the source and target models, meaning that you should not need to re-organise the operators after 
pasting. 

Also, when exiting (Collapse Submodel) from a sub-model (including Iterators) the zoom extent that was in 
use at the time of entering the sub-model is reconstructed so that you do not unexpectedly jump to a different 
part of the Spatial Model.  

New Photogrammetry Workflows in Spatial Modeler 

Over the past several years, the amount of data acquired by image acquisition systems has grown 
exponentially not least because of the advent and proliferation of lower-cost UAV platforms. This effect is seen 
not only in the spatial resolution of the imagery but also in the frequency of acquisition, with daily revisit rates 
becoming the norm. With that comes the need to automatically process the data with a very short turnaround 
time.  

Photogrammetry workflows (adjustment, ortho rectification, color balancing, mosaicing) are usually the initial 
steps of data processing. To handle the large volume of imagery, photogrammetric solutions that can be 
configured to detect new acquisitions automatically, process data as soon as it becomes available, scale up 
computing resources as needed, and feed output to downstream geospatial processes, are needed.  

Spatial Modeler is designed to solve these kinds of challenges. It has hundreds of operators that can easily be 
chained together into models that solve complex Geospatial problems.  

With this release, we have expanded Spatial Modeler’s capabilities by adding a new suite of photogrammetry 
operators that perform project setup, automatic point measurement, triangulation and mosaicing for scanned 
frame and digital frame cameras. Note that many of these new operators require additional licensing in order 
to run as part of a spatial model execution. This is generally noted in the Help for each operator. 

Add Images to Block 

 

Requires IMAGINE Advantage or higher licenses in order to run. 

This operator adds images to a block which is being processed within a Spatial Model. The images must be of 
the same sensor model types as that for which the block was created. As part of this process, interior 
orientation of the images are solved. The status of the exterior orientation of the images is also set according 
to the value specified in the parameter dictionary. 

If the image is not found in the path specified in the parameters, it is set as offline and will not be included in 
downstream processes until the correct path is set. 
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Add Terrains to Block 

 

Requires IMAGINE Advantage or higher licenses in order to run. 

The operator adds one or more digital terrain models to a block. The added terrain data could be used in 
operations such as ortho rectification and mosaicking where the block is used as input. 

Block Information 

 

Provides basic information about a block, including the Sensor Category it has been defined to handle, the 
CRS, etc. 

Block Input 

 

Reads a Block file (such as that created by IMAGINE Photogrammetry, or the Block Output operator) into a 
form that can be utilised inside a Spatial Model.  

Block Output 

 

Saves the contents of the given block as a file. The output file will have the name given by FilenameIn, if this is 
empty then a temporary name will be generated. In either case the name of the resulting file will be available 
as FilenameOut. This will be an IMAGINE Photogrammetry block file and can be opened, viewed and 
manipulated in IMAGINE Photogrammetry. 
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Create Block 

 

Requires IMAGINE Advantage or higher licenses in order to run. 

Creates a photogrammetric project called a block. The type of sensor model for the block is determined by 
BlockParameters. 

Spatial Modeler supports creating block files for several sensor models: Camera, RPC, and Rigorous sensor 
models. For each sensor type, a "Define Sensor Parameters for <Sensor type>" operator collects the 
parameters needed to define a block file for the sensor. The information collected by this operator is then 
passed to the Create Block operator via the BlockParameters port. For example, to create a camera model 
block file, use the "Define Block Parameters For Camera Model" operator to collect information for the 
parameters that are needed to set up the block file. 

Create SGM Point Cloud Output 

 

Requires IMAGINE DSM Extractor or equivalent licenses in order to run. 

This operator extracts a dense point cloud from a pair of stereo images using Semi-Global Matching (SGM). 

Left: Spatial Model for generating point cloud from a stereo pair. Right: generated Point cloud displayed as 
surface model 
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Define Adjustment Options for Camera Model 

 

This operator assembles the options that can be used to affect the results of the Run Bundle Adjustment 
operator process when run on Camera Model blocks. The detailed descriptions of these options can be found 
in the aerial triangulation help. 

 

Define Block Parameters For Camera Model 

 

Defines parameters needed for setting up a block of camera images 
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Define Camera Parameters For Digital Camera 

 

Defines the parameters for a specific digital camera. For example: 
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Define Camera Parameters For Frame Camera 

 

Defines the parameters for a specific frame camera. 

Define Image Parameters For Camera Model 

 

This creates a set of image parameters that are used when adding a camera sensor model to an image. 
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Define Mosaic Input Options 

 

This operator defines input options used with the Mosaic Images operator, such as the Active Area Method for 
determining the footprint of the input images to use and the elevation source to be used if orthorectification 
might be applied as part of the mosaicing process.  

Define Mosaic Output Options 

 

Defines output options used with the Mosaic Images operator, such as the cell size, coordinate reference 
system and resampling technique to apply. 

Define Mosaic Radiometry Options 

 

Defines options used to apply color correction on input images in the Mosaic Images operator, such as the 
Histogram Matching Method to be used to tonally balance the input images. 

Define Mosaic Seamline Options 

 

Defines seamline generation and processing options used with the Mosaic Images operator, such as the 
distance away from the seamline locations to feather. 
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Define Point Match Options 

 

This operator defines the point match options to be used with the Generate Tie Points operator, such as the 
number of points to generate per image. 

Generate Tie Points 

 

Requires IMAGINE Photogrammetry licenses in order to run. 

Automatically locate tie points for a list of images provided by an input Block. 

Mosaic Images 

 

Requires IMAGINE Advantage or higher licenses in order to run. 

Apply mosaicking operation on input images (generally defined by a Block). 
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Oriented Raster Input 

 

This operator creates an oriented image from a solved photogrammetry project (Block). The image, which 
must be present in the Block project, is oriented based on the 3D model information present in the project. 

Run Bundle Adjustment 

 

Requires IMAGINE Photogrammetry licenses in order to run. 

This operator will perform triangulation on the images in the input block using the control points, tie points, and 
check points in the block. The triangulation is considered successful if the iteration converges and the Root 
Mean Square Error (RMSE) is less than the specified threshold value. A warning message will be logged and 
BlockOut will be empty if the triangulation is not successful. 

Parameters for the triangulation can be specified as a dictionary to the AdjustmentOptions input port. 

The AdjustmentOptions dictionary can be generated by one of the "Define Adjustment Options For <sensor 
category> Model" operators. For example, the "Define Adjustment Options For Camera Model" operator can 
be used to create a dictionary that specifies parameter values for a camera model. 

Update Data Paths In Block 

 

Requires IMAGINE Advantage or higher licenses in order to run. 

A block contains references to datasets that exist in the file system. The references are in the form of 
complete paths and there are actions that can cause the paths to become invalid. For example, if data is 
moved or if the entire project is moved, then these paths will need to be updated. This operator updates the 
paths of data (images, terrains and orthos) in the block based on the specified directory to search. 

It looks for data in the specified Directory and its sub-folders if IncludeSubFolders is set to true that match the 
root names of the data in the block, and if found, their path in the block will be updated to the new data path. 

If no paths can be updated, it is an error. If some, but not all, paths can be updated, a warning will be issued. 
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Read Image Parameters For Camera Model 

 

This operator reads the image parameters for a camera model for one or more images from the text file 
referenced on the Filename port. The parameter set for each image is output as a dictionary which has the 
same form as that constructed by the Define Image Parameters For Camera Model operator and, thus, may 
be used as input to the Add Images To Block operator.  

The project information for camera projects of photogrammetric software packages that provide a means of 
exporting project information to a text file may be imported in this manner. 

HPF Resolution Merge 

Based on customer feedback the HPF Resolution Merge technique for pan sharpening data has been 
modernized to use Spatial Modeler. This means it now has View and Preview options on the dialog, as well as 
avoiding some former issues such as the introduction of pixels with values of 0 in darker areas of the data 
(which were perceived as “holes” by some geospatial applications).  
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Format Support 

DiMAP v2 RPC auto-association 

DiMAP v2 formats (such as SPOT 6, SPOT 7, Pleiades, etc) will now automatically associate any RPC 
information (if present and pertinent) with the imagery to increase the default spatial accuracy of the data.  

This also makes it much easier to batch ortho-rectify such imagery without needing to measure GCPs or 
manually associate RPC information before using the Raster tab > Geometry group > Geometric 
Calibration menu > Orthorectify without GCP utility. 

Reading of DiMAP V2 imagery should also be significantly faster in this release.  

EXIF and XMP tag support in JFIF (JPEG) and TIFF 

With the increase in popularity of lower-cost camera platforms has come an increased use of additional 
metadata stored inside image files such as TIFF and the JPEG File Interchange Format (JFIF) using tags such 
as EXIF (Exchangeable Image File) and XMP (Adobe’s Extensible Metadata Platform). 

Common examples are the Lat / Lon at which a picture was taken with a hand-help camera, or flight heading 
information for a drone image. 

These optional tags can now be read by ERDAS IMAGINE and used to define processing parameters in 
Spatial Modeler: 
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Below is a spatial model showing how to extract camera position and orientation information at the time of 
image capture: 

 

OSDDEF BIIF support updated 

Similarly to the use of EXIF and XMP tags, support for Text segments in OSDDEF BIIF profile data has been 
enhanced to decode and expose additional image parameters (for example, by using the Metadata Input 
operator in Spatial Modeler to read flying height information).  

Pleiades Neo 

In early 2021 Airbus will launch four identical new generation satellites to join its existing constellation of 
optical and radar satellites to offer enhanced performance. 

Airbus has provided pre-launch prototype image samples and documentation and support for these DiMAP v2 
data has been added to ERDAS IMAGINE 2020 Update 2. Further optimisations will occur as additional 
samples are provided.  

ICEYE 

ICEYE’s small satellite SAR imaging constellation is customized for the high revisit rate and frequent delivery 
of high-resolution imagery. 

Sample GRD data that has been provided is now supported. Further optimisations will occur as additional 
samples are delivered. 

Capella 

Capella Space recently launched the first of their X-Band SAR satellite constellation, the Sequoia satellite.  

Prototype GEO data that has been provided is now supported. Further optimisations will occur as additional 
samples are delivered. 

TRE Decoding support for MIE4NITF 

The following additional TREs are now decoded from the NITF container 

MTIMSA - This TRE specifies the nominal frame rate, frame numbers and time stamps for the Motion Imagery 
data within the Image Segment in which the TRE is found. Ties this information back to the phenomenological 
layer, camera set, camera, time interval and temporal block associated with the Image Segment. 

https://www.intelligence-airbusds.com/en/8671-pleiades-neo-trusted-intelligence
https://www.iceye.com/sar-data
https://www.capellaspace.com/technology/
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MIMCSA - This TRE contains high level metadata regarding the frame rate range of the Motion Imagery, 
encoding methods used and if any temporal subsampling was performed. 

TMINTA - This TRE Defines the start and end times for one or more time intervals. Multiple TMINTA TREs 
may be used to “on-the-fly” define time intervals as data is being collected. The TMINTA containing the time 
interval definitions for the MI data within a file resides in that file. A given file may also have TMINTA TREs 
from other files that correspond to one or more “temporally adjacent” time intervals. 

MTIMFA - This TRE Specifies how the Motion Imagery data for all cameras in a phenomenological layer for a 
given camera set and time interval are subdivided into temporal blocks. Also associates the temporal blocks to 
the Image Segment index. 

CAMSDA - This TRE defines the camera sets, places cameras on the CCS, assigns phenomenological layer 
IDs and UUIDs to all cameras in the collection.  

CSEXRB - Common Sensor Exploitation Reference Data. 

NITF 27-bit J2K 

27-bit J2K images stored in a 32-bit word in NITF 2.1 were previously not displaying consistently. The 

underlying JPEG 2000 decoding libraries have been updated to properly decode this type of data.  

SNIP NITF 

SNIP NITF data support has been updated to conform with the latest released specification, including 
decoding of additional DES and TRE (CSATTB, ILLUMA, ILLUMB, CCINFA, MATESA, PIXMTA, CSEPHB, 
CSCSDB, CSSFAB)  

DED segments in NITF 

The Digital Elevation Data (DED) segments that may be embedded in some NITF file containers are now 
readable as a sub-image. 

BadPixelSegment in NITF 

The BadPixelSegment data now defaults to Thematic display mode when opened using the Image Chains, 
applies appropriate colors, and a legend in the Properties pane. 

12-bit YCbrCr TIFF 

Some 12-bit TIFF imagery (that using YCbrCr JPEG compression) was formerly being interpreted by ERDAS 
IMAGINE as 8-bit data. This has been enhanced so that the data is correctly decoded and treated as 12-bit. 

Please note that this means that any existing YCbrCr JPEG TIFF images which had been opened in older 
versions of ERDAS IMAGINE may have incorrect statistics, histogram information and pyramids stored in .aux 
and .rrd files (resulting in washed-out, or all white, display). These ancillary files should be deleted and 
regenerated using ERDAS IMAGINE 2020 Update 2 for correct display. 

Sentinel-1  

Reading of Sentinel-1 SAR imagery should be significantly faster in this release. 

Sentinel-3 

Sentinel-3 SAFE data (where the raster data is stored in NetCDF files) can now be directly read, including 

geocoding information.  
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DTED 

Reading of DTED raster data should be significantly faster in this release. 

PlanetScope Level 3 

PlanetScope Level 3A and 3B data can now be directly read via its XML header file 

HDF 5 

There is a new raster format direct read for HDF 5 files such as multi-segment ASTER Global Emissivity Data 
(GED) V003.  

Esri *.asc 

Esri *.asc files delivered with .prj files can now be correctly read 

SocetSet GRID 

SocetSet GRID files containing mixed data types 

PRISMA 

PRISMA Level 1 and 2 HDF EOS 5 formatted data can now be directly read.  
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General ERDAS IMAGINE 

Related Data in 2D View 

Data no longer necessarily follows a "one file, one dataset" pattern. Formats such as GeoPackage, NITF and 
HDF are all capable of storing multiple related sets of data within a single file. When such a file is dragged and 
dropped into an ERDAS IMAGINE 2D, 3D, or Map Views there will be a default behavior which accesses one 
of the constituent datasets and displays it. If using the File Chooser to select the file, a Sub-images (or similar 
tab) may be displayed enabling the constituent datasets to be explored and selected for use. However, in both 
instances, once initially selected it may not be obvious to the user of the software that additional data may be 
available from the file that has been displayed. 

That’s where the Related Data section of the Contents panel comes in. For each such constituent raster 
dataset in a displayed parent file, a sub-image proxy file (.sbi) will be automatically created alongside the 
original parent file. If the original parent file is a GeoPackage that contains features, GeoPackage Features 
proxy files (.gfp) will be automatically created for each constituent feature dataset; the .gfp files will be create 
in a sub-directory (<original filename>.proxy) alongside the original parent file. If the original parent file is a 
NITF that contains shapefiles, the shapefiles will be automatically extracted alongside the original parent file. 
The proxy files and extracted shapefiles can be used to process constituent data in other ERDAS IMAGINE 
tools. 
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Machine Learning Layout Improvements 

The Machine Learning Layout ribbon tabs (File tab > Layout > Machine Learning Layout) have been re-
organized in an effort to increase productivity. The Layout now has two main tabs. 

Collect Tab – This tab is for extracting training image chips and/or footprints to be used for initializing Machine 
Intellects. 

Process Tab –This tab is mainly for setting up, processing, and managing a Deep Learning based 
classification or Object detection project. Initialization/Training of Machine Intellects, Classification/Object 
detection and review of the results after processing is performed on this tab. 

In addition to the reorganization of the ribbon tabs, the following features have been added to the layout: 

• Object Detection Workflow – Initializing/training an object detection network and performing object 
detection workflow, which used to be available only in Spatial Modeler, is also now available in the 
Layout.  

• Importing an Initialized Machine Intellect – Machine Intellects that are initialized outside the Machine 
Learning layout framework can be imported to the layout and be used for performing classification or 
Object Detection. This is done using the Load Machine Intellect option from Process Tab > Initialize 
Group > Review Result drop-down menu. 

 

Inquire Cursor “Live Update” Option 

The ribbon-embedded Inquire Cursor has had a Live Update option added. When enabled the Inquire Cursor 
will continuously update the values shown in the CellArray as the cursor is dragged around the 2D View rather 
than on release of the cursor. 

Projected Coordinate Systems 

The following changes to Projected Coordinate System support have been made: 

Three Malaysian RSO projections which had their EPSG codes missing have been added. 
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Australian GDA 2020 zones have been exposed in the Australia category of the Projection Chooser for ease 
of selection. 

The CARIB97 vertical datum has been added.  

Canadian Geodetic Vertical Datum of 2013 (CGVD2013) is now supported.  

Auto-rotation of Image Chains based on SIPS rules 

When an image is initially displayed using the Image Chain method a set of SIPS control files will be 
referenced to determine if the type of sensor should have its data displayed as File, North or Up as Up in the 
2D View.  

For example, DigitalGlobe WorldView-2 NITF data may be rotated to Up is Up by default. 

This behavior can be overridden via a new Preference if File is Up is preferred (Preference Editor > Viewing > 
Image Chain > Follow SIPS Rotation Behavior > On/Off). 

Histogram Manipulation for Image Chains 

Manual Dynamic Range Adjustment (DRA) has been made visually easier. When displaying imagery via the 
Image Chains the Stretch Panel now enables displaying the input and output histograms as well as the 
breakpoints defined by the default DRA parameters. A user can then easily slide the minimum and maximum 
breakpoints and see the effect on the current histogram caused by the updated look-up table (LUT) values. 
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Profile Tools Enabled for Image Chains 

The three Profile tools (Spectral, Surface and Profile) all now work with data displayed as Image Chains, such 
as this intervisibility spatial profile defined over a DEM displayed using the Relief Image Chain: 

 

Additional Tabs Enabled with Image Chains 

The Drawing and Format tabs are now present when data displayed via the Image Chain is active. Most tools 
on those tabs will operate as normal. 
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Region Grow with Image Chains 

One example of a tool now accessible through the Drawing tab for Image Chains is the Grow utility for 
assisted feature extraction. 
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Consolidated Rotation Menus 

 

Options for rotating imagery to specific values (such as Up is Up, the sensor look direction) were repeated in 
differing locations of the ribbon interface and sometimes duplicated but using differing terminology. This has 
been rationalised so that consistent terminology is used and the options are replicated where it makes sense 
for ease of access to the options. 

Sentinel-1 E-Z Coherence Change 

The Sentinel-1 E-Z Coherence Change utility has been updated to enable use of Sentinel-1 A and B satellite 
data (i.e. it is no longer limited to a single orbit path). 

Sentinel-1 Orbit Correction 

This functionality allows the analyst to update the orbit ephemeris data of a Sentinel-1 image with parameters 
downloaded from the ESA website. This will permanently change the metadata of the image and the new 
metadata will be used for all subsequent processing. 
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Sentinel-1 Beta-0 Conversions 

The Radiometric Conversions (Beta-0) utility now supports Sentinel-1 imagery. This utility converts each pixel 
from the DN value distributed by the Receiving Station to the absolute radiometry as received by the sensor. 
This is done by using the metadata supplied with each scene by the Receiving Station. 

 

I & Q to/from Magnitude Phase Conversion  

This functionality allows the analyst to convert pixel values from In-Phase and Quadrature into Magnitude and 
Phase. Radar pixel values are commonly stored, as received, as In-phase and Quadrature components. 
These are generally converted into Magnitude and Phase as this representation is more useful; Magnitude for 
visual interpretation and Phase for interferometry. 

Usually the ERDAS IMAGINE raster read DLLs, which are used to read the data files and display an image in 
the 2D Viewer or other applications, automatically convert the I&Q disc storage into Magnitude and Phase. 
Thus, most customers will never need to use these conversions. 

Some radar sensors, such as those on UAVs or government assets, do not have ERDAS IMAGINE supplied 
raster read DLLs. For these sensors, it may be necessary to converts the I & Q format prior to analyzing in 
ERDAS IMAGINE. Or it may be desirable to convert a Magnitude & Phase image back into the more basic I & 
Q format. Again, this is not common. 
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Linear to/from Decibel Conversion 

Radar image pixel values can be analyzed in either a linear or logarithmic distribution. The logarithmic 
distribution is traditionally termed Decibels. This utility provides conversion from one to the other. 

Support 

To assist in troubleshooting issues which may occur in the software the Session Log now lists the full build 
number associated with the installed version of ERDAS IMAGINE, as well as specifying the Spatial Modeler 
SDK (SMSDK) it was built upon. This information is also present in the System Report file which can be 
produced. For example, the Session Log may look like this: 

Session Log 

------------------- 

User: jdoe 

Date: Wed Oct 21 15:34:29 2020 

Host: myserver 

OS Version: Windows NT 6.2 Build 9200  

GPU: Available 

Locale: en-US 

Software: ERDAS IMAGINE 2020 

Version: 16.6.0.1920 

Spatial Modeler SDK Version: 16.6.0.2006 
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System Requirements 

ERDAS IMAGINE  

Computer/ Processor 
64-bit: Intel 64 (EM64T), AMD 64, or equivalent n(four or more logical processors are strongly 
recommended) 

Memory (RAM) 16 GB or more strongly recommended 

Disk Space 

• 6 GB for software 

• 7 GB for example data 

• Data storage requirements vary by mapping project1  

Operating Systems 2, 3, 

4 

• Windows 10 Pro (64-bit) 

• Windows 10 Enterprise (64-bit) 

• Windows Server 2016 (64-bit) 

• Windows Server 2019 (64-bit) 

Software 

• OpenGL 2.1 or higher (this typically comes with supported graphics cards 5) 

• Java Runtime 1.7.0.80 or higher - IMAGINE Objective requires JRE and can utilize any installed 
and configured JRE of version 1.7.0.80 or higher. 

• Python 3.6.x or 3.7.x (Python is optionally usable with Spatial Modeler).  

• Microsoft DirectX® 9c or higher 

• .NET Framework 4.7.2 or higher 

• OpenCL 1.2 with a device that supports double precision (cl_khr_fp64) if wanting to GPU accelerate 
NNDiffuse and other Operators 

• An NVIDIA card with CUDA capabilities is recommended for use with Deep Learning 

Recommended 
Graphics Cards for 
Stereo Display 6 

• NVIDIA® Quadro® P6000, P5000, P4000, P2000 

• NVIDIA® Quadro® M6000, M5000, M4000, M2000 

• NVIDIA® Quadro® K5200, K5000, K4200, K4000, K2200, K600, K420  

Recommended Stereo 
Display Monitors 

• 120 Hz (or above) LCD Monitors with NVIDIA 3D Vision™ Kit, or 

• 3D PluraView system from Schneider Digital 7 

Peripherals 

All software installations require: 

• One Windows-compatible mouse with scroll wheel or equivalent input device  

• Printing requires Windows-supported hardcopy devices 8  

Software security (Hexagon Geospatial Licensing 2020) requires one of the following: 

• Ethernet card, or  

• One USB port for hardware key 

Advanced data collection requires one of the following hand controllers: 9 

• TopoMouse™ or TopoMouse USB™ 

• Immersion 3D Mouse 

• MOUSE-TRAK  

• Stealth 3D (Immersion), S3D-E type, Serial Port 

• Stealth Z, S2-Z model, USB version 

• Stealth V, S3-V type (add as a serial device) 

• 3Dconnexion SpaceMouse Pro 10 

• 3Dconnexion SpaceExplorer mouse 10 

• EK2000 Hand Wheels 

• EMSEN Hand Wheels 

https://www.3d-pluraview.com/en/


ERDAS IMAGINE 2020 Update 2 

  53 

• Z/I Mouse 

ArcGIS and GeoMedia 
Interoperability 

• ERDAS IMAGINE can be safely installed on a computer that has GeoMedia 2018 or GeoMedia 
2020 installed. However, for greatest compatibility, it is highly recommended to install matching 
versions (including Updates). 

• ERDAS IMAGINE 2020 requires GeoMedia 2020 for live linking. Order of installation does not 
matter. 

• ERDAS IMAGINE can interact with both types of personal Geodatabases (*.mdb and *.gdb). 

• ERDAS IMAGINE can be safely installed on a computer that has ArcGIS® versions 10.6 through 
10.8.1. 

• ERDAS IMAGINE and IMAGINE Photogrammetry (32-bit) can interact with ArcGIS Server 10.6 – 
10.8.1 Geodatabase servers (ArcSDE). To read or interact with an Enterprise Geodatabase, you 
must either:  

o Install and license the appropriate version of ArcGIS for Desktop versions 10.6 
through 10.8.1, OR  

o Install the IMAGINE Geodatabase Support (based on ArcEngine 10.7) - requires no 
license 

Database Engines 

• PostgreSQL 9.6 with PostGIS 2.3: PostGIS can be used to store GeoMedia Features (.pfp) 

• Oracle Server 12c 12.2 64-bit: Oracle Server 12c can be used to store Oracle GeoRaster (.ogr) 
(requires Oracle Spatial), SDE Raster (.sdi) (requires ArcGIS for Server) and Oracle Spatial 
Features (.ogv) (requires Oracle Spatial), as well as GeoMedia Features (.ofp). 

• Microsoft SQL Server 2017 64-bit: Microsoft SQL Server 2017 can be used to store GeoMedia 
Features (.sfp) 

ERDAS IMAGINE System Requirements Notes 
1 Disk I/O is usually the slowest task in geospatial data processing. Faster hard disks improve productivity. 
Reading data from one disk, writing temporary data to a second disk, and writing data to a third disk improves 
performance. Disk arrays improve productivity, but some RAID options slow performance. Network disk drives 
are subject to network limitations.  

2 Server Operating Systems are not supported for IMAGINE Photogrammetry, ORIMA or ERDAS ER Mapper. 

3 The 3D stereo viewing and peripheral requirements of IMAGINE Photogrammetry limit its operating system 
options.  

4 ERDAS ER Mapper is not supported on Windows 8. It is considered Viable on Windows 8.1. 

5 Windows provides a generic OpenGL driver for all supported graphics cards. However, an OpenGL-
optimized graphics card and driver are recommended for these applications.  

6 Graphics cards certified with previous versions of IMAGINE Photogrammetry and ORIMA may also be 
compatible, but are not certified in the current version. Drivers must not be newer than R418. NVidia dropped 
3D Vision support for drivers released after R418 U4 (425.31), which was released on April 11, 2019. 

7 Stereo Monitors certified with previous versions of IMAGINE Photogrammetry and ORIMA may also be 
compatible, but are not certified in the current version. 

8 HP-RTL drivers are recommended. Windows 64-bit print servers require 64-bit print drivers.  

9 Stealth S-Mouse (S2-S model) and MOUSE-TRAK are the only supported hand controllers in Stereo Analyst 
for ERDAS IMAGINE.  

10 3Dconnexion mice are supported in IMAGINE Photogrammetry.  
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Issues Resolved – ERDAS IMAGINE 2020 
Update 2 

IMAGINE Essentials 

Issue ID Summary – 
IMAGINE 
Essentials 

Description / How to Reproduce 

00055139 Roaming an 
image displayed 
on top of 
OpenStreetMap 
basemap crashes 
ERDAS IMAGINE 
2020 

Reproduced this issue with a specific image: 
 
1. Load the Gdansk_Lostowice_5cm.tif image to the 2D View 
2. Open Home>Basemap>OpenStreetMap 
3. Zoom in, zoom out, pan and after about 1 minute ERDAS IMAGINE will crash 

00038767 ERDAS IMAGINE 
2018 Update 2 
gives error while 
opening a (GDAL 
created) IMG file 
in the Viewer 

Customer reported that while opening an *.img file in IMAGINE 2018 update2 Viewer, IMAGINE 
gives the following error messages: 
 
Spatial Model failed in Raster Input. The error was "eimg_AllStatsStackRead failed 
eimg_AllStatsStackRead failed 
eimg_StatisticsGetSkipFactors failed 
eimg_LayerScalarStatisticsParametersRead failed 
StatisticsParametersRead failed 
FileDataRead failed 
emif_ConvertToHost failed 
emif_MIFtoObject failed 
emif_MIFtoBaseData failed 
No memory" 
 
IMAGINE opens the file in the viewer, but the error message is not desirable. Converting the GDAL 
IMG to another IMG using ERDAS IMAGINE solves the issue. Appears to be caused by GDAL not 
correctly populating the statistics node. 

00009390 APOLLO 
Essentials ECWP 
slower in ERDAS 
IMAGINE than in 
other GIS 
applications 

When opening any ECWP within ERDAS IMAGINE the display speed is considerably slower in 
comparison to other GIS applications. 

00065411 S3 connection 
fails when region 
of S3 bucket is 
not ‘us-east-1’ 

A user located outside of the U.S. is experiencing a problem when trying to connect to their S3 
bucket in ERDAS IMAGINE 2020. The error says: 
 
Unable to parse ExceptionName: AuthorizationHeaderMalformed Message: The authorization 
header is malformed; the region ‘us-east-1’ is wrong; expecting ‘eu-central-1’ 
 
They have tried to specify the region with a ‘config’ file in C:\Users\USERNAME\.aws, but it did not 
resolve the problem. 

00070931 Inquire Box error - 
Datum undefined, 
unable to perform 
geodetic 
transformation 

When using the Inquire Box with an image that is not projected to Geographic Lat/Lon, if you 
change the Inquire Box’s coordinate Type to Lat/Lon and click the Apply button it causes the error 
“Datum undefined, unable to perform geodetic transformation". The error does not occur in ERDAS 
IMAGINE 2018 Update 2 (v16.5.2). 
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00059178 Missing Auto 
Variable for World 
Files output in 
Image Command 
Batch Editor 

A customer would like to generate hundreds of *.j2w world files (e.g. for *.jp2 files) using the Image 
Command in batch mode. The default setting in this command for the "World File" output variable 
seems to be "User". This setting forces the user to switch to "Auto" and define a pattern which, 
according to the rules for world files, cannot be other than the same path and name as the input, 
but with a different extension.  
 
The Auto Variable with pre-defined pattern works in other commands in batch mode, e.g. in the 
"Reproject" command after having selected "One or more inputs, one output". 
 
To reproduce: 
1. Run Edit Image Metadata from Manage Data tab 
2. Select one input file from data - lanier.jp2 
3. Activate Map Model to World File option 
4. Click Batch 
5. In the Batch Command Editor you can see that WorldFile column populated with correct path 
and extension. 
6. Use Add Files... to load the rest of the images. World File column for those will not be filled. 
 
Usually "One or more inputs, one output" option allows to use the pre-defined pattern. In this case 
you always need to manually define pattern for World Files along with extension: 
 
Next to the Variables line click Edit 
Select WorldFile variable. Define the Type to Auto and past following to the Pattern line 
$(Input.Path)$(Input.Root).j2w 
Once the pattern defined, click close. The WorldFile column will be populated with corresponding 
filenames. 

00050270 Importer for ENVI 
HSI .hdr format 
fails with large 
input data 

Import ENVI HSI .hdr format to IMG fails with larger input data (~30GB+) 
 
To see problem 
 

1. Manage Data > Import Data 
2. Format: ENVI/AISA Hyperspectral (Direct Read) 
3. Input File: \\alpha\JIRA_data\IM-50434\SP_PD_P_160202_1941_A.hdr 
4. Output File: (enter user specified location and filename) 
5. After ENVI/AISA Hyperspectral (Direct Read) opens, select OK (using all defaults) 

  
Import starts, then recurring errors are thrown. Neither the OK and OK to All error dialogue or the 
Process List Kill are responsive to terminating the task. The imgcopy.exe task may have to be killed 
through Windows Task Manager. 
 
 
23/08/19 15:35:17 SessionMgr(5044): ERROR: #8087 from efio_Seek 
 
23/08/19 15:35:17 SessionMgr(5044): ERROR: Unable to perform seek on 
c:\data\sfdc\00050270_envi_hsi\data\sp_pd_p_160202_1941_a.img 
 
23/08/19 15:35:17 SessionMgr(5044): ERROR: #7930 from efio_Win32Seek 
 
23/08/19 15:35:17 SessionMgr(5044): ERROR: Unable to seek to byte offset -2135024896 in 
c:\data\sfdc\00050270_envi_hsi\data\sp_pd_p_160202_1941_a.img 
 
23/08/19 15:35:17 Unknown error code - 131 
 
23/08/19 15:35:17 SessionMgr(5044): ERROR: #8087 from efio_Seek 
 
23/08/19 15:35:17 SessionMgr(5044): ERROR: Unable to perform seek on 
c:\data\sfdc\00050270_envi_hsi\data\sp_pd_p_160202_1941_a.img 
 
23/08/19 15:35:17 SessionMgr(5044): ERROR: #7930 from efio_Win32Seek 
 
23/08/19 15:35:17 SessionMgr(5044): ERROR: Unable to seek to byte offset -2127170560 in 
c:\data\sfdc\00050270_envi_hsi\data\sp_pd_p_160202_1941_a.img 
 
23/08/19 15:35:17 Unknown error code - 131 
 
 
The importer is reported to run successfully using smaller input data sizes (~400MB). Smaller data 
was not included with the sample data. Will request smaller working sample data. 
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00050270 ENVI Importer 
output image 
projection is 
defined differently 
from the HDR 
projection 
parameters 

The projection parameters assigned to the output image from the ENVI importer are different than 
the projection parameters in the ENVI .hdr file. 
 
The Spheroid/Datum is expected to be assigned is WGS 84, not GRS 1980/NAD83 

00058100 Stop the crash: 
ECW data cannot 
be saved after 
editing via Fill or 
Interpolate 
functions 

To reproduce: 
 

1. Open attached TheVillagesSubset2008.ecw image in 2DView 
2. Follow the Edit Value of a Single Pixel workflow 

https://hexagongeospatial.fluidtopics.net/reader/XWswM6TZr3V__hu3iKjbGA/f7HPLVFq
pmWzNyjg2YvpBQ 

3. Right-click on the image in Contents window and click Save Layer As... . 
4. Specify the output file name and pick ECW as file format. Right after creating output file, 

ERDAS IMAGINE will crash. The output file will have no edits applied. 
 
If you save the layer to IMG format, it will be processed successfully. But saving to ECW format is 
crashing ERDAS IMAGINE. Same behavior after editing using Interpolate tool (Multispectral Tab > 
Edit Group) 

00067214 Map coordinate 
and projection 
information isn’t 
written to output 
JPEG 2000 image 
file 

Map and Projection information from the input raster isn’t written to the .JP2 output raster file itself. 
Spatial information is written to the associated .aux file. This can be an issue when the JP2 raster is 
used outside of the ERDAS IMAGINE environment. This is a regression - ERDAS IMAGINE 2015 
and earlier versions do write the spatial information directly to the JP2 output raster image. 
 
To recreate: 
 
Run any ERDAS IMAGINE application that writes raster output. Specify JPEG 2000 from the ‘Files 
of Type’ menu in the ‘Output File’ dialogue window. 

00067272 Sentinel-1 data 
that is appended 
to long folder 
pathnames 
allowed by 
Windows, will not 
display in ERDAS 
IMAGINE 

Sentinel 1A data that is appended to a (long) pathname length allowed by Windows, will not display 
in ERDAS IMAGINE. Errors are returned including “Could not open TIL file” in an error dialogue 
box. 
 
To recreate: 
 
Copy the Sentinel 1A scene (and it’s et of child sub-directories) 
“S1A_IW_SLC_1SDV_20200522T083100_20200522T083129_032675_03C8D7_BCAF” to this 
pathname (or equivalent pathname length) 
“C:\Warehouses\Dataset\SMA_Imagens\Sentinel1A\S1A_IW_SLC_1SDV_20200522T083100_202
00522T083129_032675_03C8D7_BCAF” 
Attempt to display the data in the 2D View by picking Files of type ‘Sentinel-1 SLC’ and selecting 
“s1a-iw1-slc-vh-20190811t070240-20190811t070305-028518-033965-001.xml” from the scene 
‘annotation’ folder. 

00049419 Issue reading 
JPEG 2000 raster 
format produced 
by IPP sdk 

JP2 image reads improperly in ERDAS IMAGINE 2018 (as a noisy image), while correctly in 
ERDAS IMAGINE 2016 and other GIS applications. The Metadata tool shows that ERDAS 
IMAGINE 2018 changes pixel values when reading this image.  
 
To produce this image customer has used following: IPP sdk from Intel. Version 7.0 . build version 
205. 

00062796, 
00061155 

"ERROR: 
Unexpected byte 
count after 
conversion from 
ANSI Code Page 
(936)" with 
Chinese locale 

Customer reports this error when running different programs (Layer Stack, Spatial Modeler). The 
errors seem to occur when the applications attempt to open the data. 
 
The problem was initially reported at the Hexagon Geospatial Community. A ticket was submitted, 
and testing indicates the problem is related to the Chinese Windows locale ‘zh-CN’. The customer 
verified the problems are not seen after switching the system to locale 'en-US'. 
 
ERROR: Unexpected byte count after conversion from ANSI Code Page (936) 
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00008451 Printing map 
composition using 
"Fit to one Panel" 
option relocates 
North arrow and 
scale bar 
positions 

Printing a map composition using the "Fit to one Panel" option moves the North arrow and scale 
bar to different map positions. Other map elements (symbols, text, map frames) maintain their 
relative map position. ). This happens when printing to PDF, GeoPDF, and printers with a smaller 
page size than the map composition. The map frame is scaled to fit one panel, but the scale bar 
and North arrow are repositioned and resized. 

00061924 Export lossy 
MrSID from an 
img/ige large input 
does not write a 
valid raster output 

Export MrSID does not create a valid output if ‘Lossless compression’ is unselected. If ‘Lossless 
compression’ is selected a usable output is generated. 
 
 

00038716 TIFF image (with 
Tie Points) that 
crosses over 
International Date 
Line does not 
display correctly 

A TIFF image that crosses over the International Date Line does not display correctly. 
 
If you do not use the Orient Image to Map System raster option when opening the file then ERDAS 
IMAGINE will display the image, but the session log reports the error “RMS error for this polynomial 
approximation is too high: 89.999861.” If you then try to display the OpenStreetMap basemap in 
the same 2D View the image becomes a long, thin horizontal line. 
 
If you use the Orient Image to Map System raster option when opening the file the image is 
displayed as a long, thin horizontal line and the session log reports the same error “RMS error for 
this polynomial approximation is too high: 89.999861.” 
 
The image cannot be displayed in Geospatial Portal or ERDAS APOLLO Data Manager. 
 
The TIFF image supplied by the customer crosses over the International Date Line. The reference 
projection is Geographic Lat/Lon. 

00057431 Coordinate 
Calculator 
crashes when 
setting output 
projection 

The Coordinate Calculator tool crashes with the error “coordcalc.exe exited with status -
1073741819“ in the 64-bit version of ERDAS IMAGINE 2020 Update 1 when you set the output 
projection. The problem does not happen when using the 32-bit version of ERDAS IMAGINE 2020 
Update 1 or ERDAS IMAGINE 2018 (the Coordinate Calculator is still a 32-bit app in the 64-bit 
version of ERDAS IMAGINE 2018). 
 
Steps to reproduce problem: 
 

1. Start the Coordinate Calculator tool (Manage Data tab > Conversion group > Coordinate 
Calculator). 

2. Load the provided coordinate file “atl_state_plane.gcc” (File > Load). 
3. Set the output projection (Projection > Set Output Projection and Units) 
4. In the Output Projection and Units Setup dialog click the Set Output Projection button. 
5. In the Projection Chooser dialog set the projection to “UTM Clarke 1866 NAD27 North, 

Zone 16” and click OK. 
6. Click OK in the Output Projection and Units Setup dialog. 
7. The Coordinate Calculator crashes, and the session log reports “coordcalc.exe exited 

with status -1073741819“. 

00063017, 
00062863, 
00059127 

Cannot read 
Sentinel-1 GRD 
image using the 
xml header file 

ERDAS IMAGINE crashes when reading Sentinel-1 GRD using XML file.  
 
To recreate: 
 
Display the Sentinel-1 GRD image by selecting the xml file saved in the image “annotation” sub-
folder. Imagery can be successfully opened directly from the TIFF files in the “measurement” folder. 
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00061905 Resample 
calculates invalid 
resample output 
parameters for 
cell size and 
number of 
columns and rows 
with specific data 
and the Rubber 
Sheet model 

Resample calculates invalid resample output parameters for cell size and number of columns and 
rows with provided data. 
 
To replicate: 
 

1. Open provided image in 2D View 
2. Panchromatic tab > Transform & Orthocorrect group > Control Points 
3. Select Rubber Sheeting from Model List 
4. After GCP Tool Reference Setup dialogue opens, select GCP File (.gcc), OK 
5. Select clip1ref.gcc, OK, then Close 
6. File Menu > Load Input GCPs 
7. Select clip1input.gcc, then OK 
8. Select Resample icon 

 
Illogical calculations for Number rows, Number Cols, Output, and Cell size are generated. 
 
Repeat the exact same procedure using ERDAS IMAGINE 2018. Reasonable calculations are 
generated. 

00002875 “Send View to 
JPG” from Office 
Tool in ERDAS 
IMAGINE is 
creating bad 
worldfile 

Customer reported that the “Send View to JPG” from Office Tool in ERDAS IMAGINE is creating an 
incorrect worldfile. 
 
The customer wanted to use the 2D View content as a geo-registered JPEG that will work in other 
applications. According to the customer the World File that is generated has an error in the 2nd or 
3rd line. 
 
The customer added that this appears to be similar to the problem described several years ago. 
Thought it important enough to encourage Intergraph to finally solve this problem. 
 
The issue is with the skew parameters in the world file, which appear to be given very, very small 
values rather than being 0.0. 

00054109 “Raster to 
Shapefile” feature 
doesn’t create prj 
file with customer 
data. 

Customer reported that “Raster to Shapefile” feature doesn’t create prj file along with the shapefile 
sets, even if the input raster file does have projection. According to the customer the raster 
thematic file was created by Supervised Classification in ERDAS IMAGINE. 

00063822 ERDAS IMAGINE 
2020 64-bit 
crashes with 
tbbmalloc.dll as 
faulting module 

Customer reported an issue that they couldn’t start ERDAS IMAGINE 2020 64-bit from auto-save. 
Stated that an initial crash had occurred when just adding rasters to the 2D View. After that initial 
crash when launching ERDAS IMAGINE 2020, it prompts the user that there is an auto save file 
detected. When choosing YES to load the session file or NO to ignore (it doesn't matter) the 
software closes unexpectedly. 
 
Event Viewer shows: 
Faulting module path: C:\Program Files\Hexagon\ERDAS IMAGINE 
2020\bin\x64URelease\tbb\tbbmalloc.dll 
 
The issue was tracked to a problem with the Locale setting for the computer, combined with a 
problem with installed Fonts. 

00071304 Help page for 
Feature Count 
Tool doesn’t 
document 
shapefile output 
option 

Feature Count Tool has options to write output to three formats: annotation, shapefile, and text file. 
Online Help did not include the shapefile output option. 
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IMAGINE Advantage 

Issue ID Summary – IMAGINE 
Advantage 

Description / How to Reproduce 

00069646 ERDAS IMAGINE 2020 
crashes while saving 
edits to thematic image 
with shapefile on top 

There are two actions that lead to a crash. Both scenarios provided below. 
 
Scenario 1. Recode tool: 
 

1. Load 16th_naga_finalclass_83g.img to the 2D View 
2. Load 17thcycle_nagaland_rcnf_83g.shp to the 2D View 
3. Select thematic image and run Thematic tab > Edit group > Recode 
4. In the Recode window make some edits. E.g. I have selected rows from 6 to 11, 

defined new value as 6. Click Change Selected Rows and Apply. Leave Recode 
window open 

5. Select thematic image in Contents and run Table tab > View group > Show 
Attributes 

6. Right click on thematic image and pick Remove Layer. Click Yes to save edits on 
both notification messages. ERDAS IMAGINE will crash 

 
Scenario 2. Thematic raster edits: 
 

1. Load 16th_naga_finalclass_83g.img to the 2D View 
2. Load 17thcycle_nagaland_rcnf_83g.shp to the 2D View 
3. Select thematic image in Contents and run Table tab > View group > Show 

Attribute 
4. Edit e.g. color of some class 
5. Right click on thematic image and pick Remove Layer. Click Yes to save edits. 

ERDAS IMAGINE will crash 

00054277 ERDAS IMAGINE 2020 
compute statistics issue 
when using Recode 

Computing statistics using Image Metadata in ERDAS IMAGINE 2020 produces result 
different from ERDAS IMAGINE 2018. 
 
Customer uses Raster>Thematic>Recode tool since it allows to generate output file within 
the GUI. This tool reads the Row number of the thematic image as original Value. 
Customer’s data having mismatch of Row number and actual image file's value. That's why 
in his workflow, he firstly computing statistics for the input image to match the image file 
values with the Row number and then run a Recode. 
 
With the release of ERDAS IMAGINE 2020, computing statistics no longer matching those. 
To reproduce: compute statistics for the attached image using Image 
Metadata>Edit>Compute Pyramid Layers/Statistics... in ERDAS IMAGINE 2018 and in 
ERDAS IMAGINE 2020. 
 
ERDAS IMAGINE 2018 matches the image file value to the Row number, while ERDAS 
IMAGINE 2020 does not. 
 
Also, when running this image through a simple model having Raster Input -> Raster Output 
operators in ERDAS IMAGINE 2020, the histogram of the output raster changes so that Row 
number matches the image file value. Which works in the same way as ERDAS IMAGINE 
2018 computes statistics. 



ERDAS IMAGINE 2020 Update 2 

  60 

00058219 Raster Thematic Recode 
does not write correct 
IMG output using specific 
TIFF input data 

Raster Thematic Recode does not write correct IMG output using specific TIFF input data 
 
Problem can be recreated with customer data, but problem is not seen with every input file. 
Recode generates expected IMG output when using other TIFF and IMG input files. The 
sample input TIFF image is reportedly generated from other IMAGINE processes. 
 
To recreate: 
 

1. Run Raster Thematic Recode 
2. Input File: \\alpha\JIRA_data\IM-52611\wv2_4007_recode_3class_stk_v2.tif 
3. Select Setup Recode… 
4. Select Row Value = 2, Enter New Value = 1, then Change Selected Rows 
5. Select OK to dismiss Thematic Recode dialogue 
6. Select Output File icon 
7. Be sure Files of Type is set to ’IMG’ 
8. Enter output filename 
9. Then OK 

 
The process runs and throws an error at the end. 
 
Display the generated IMG output. The recoded image values appear as expected. Select 
Raster tab > *Table*. Then *Show Attributes*. The first three original rows from the input 
TIFF attribute table, but with NO Histogram column, are saved to the IMG output image. 
Calculating statistics of the IMG file using Metadata seems to repair the attribute table to the 
expected table result. 

00058219 Raster Thematic Recode 
does not write TIFF 
output using specific 
TIFF input data 

Raster Thematic Recode does not write TIFF output using specific TIFF input data 
 
Problem can be recreated with provided data but is not seen with every input file. Recode 
generates TIFF output using other TIFF and IMG input files. The sample input TIFF image is 
reportedly generated downstream from other IMAGINE 2020 processes. Recode does write 
IMG output using the same TIFF input. 
 
To recreate: 
 

1. Run Thematic Recode 
2. Input File: \\alpha\JIRA_data\IM-52608\wv2_4007_recode_3class_stk_v2.tif 
3. Select Set Recode… 
4. Select Row Value = 2, Enter New Value = 1, then Change Selected Rows 
5. Select OK to dismiss Thematic Recode dialogue 
6. Select Output File icon 
7. Change Files of Type to ’TIFF’ 
8. Enter output filename 
9. Then OK 

 
Progress meter shows successful completion of multiple subtasks, but error is thrown at the 
end 
 
No TIFF output is generated 
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00056784 Recode result is 
incorrect when output 
data values exceed bit-
depth of input 

When recoding data and the output data has a larger bit depth than the input (e.g. recoding 
from u4 bit to u16 bit, i.e., changing pixel value 3 to 300) the new values that are greater than 
4-bits are not added to the attribute table, i.e., the attribute table of the output 16-bit data has 
the same number of rows as the input 4-bit data but the new values are not mapped 
correctly. The new values that are greater than 4-bits get combined into the last row of the 
attribute table. If you use the Inquire Cursor to inspect the recoded image you can observe 
that the new recoded pixel values are written to the file.  
 
Steps to reproduce the issue: 
 

1. Open the Recode tool (Raster tab > Thematic menu > Recode) 
2. Select the attached file lnlandc.img as the input and enter a name for output file. 
3. Set the output data type to Unsigned 16-bit. 
4. Click the Setup Recode button to display the Thematic Recode dialog. 
5. Use the following values in the New Value column: 0, 1, 2, 250, 300, 305, 306, 

307, 308, 309, 310. 
6. Click OK in the Setup Recode dialog. 
7. Click OK in the Recode tool. 
8. Display the recoded image in a 2D View and open the attribute table to observe 

that the there is still only 11 rows. Any rows that were recoded with a value higher 
than 10 get squashed into the 10^th^ row. 

9. Use the Inquire Cursor to check the actual pixel values in the image and observe 
that the pixel values have in fact been changed. 

 
This process works correctly with the Recode tool in ERDAS IMAGINE 2018. 
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00067176, 
00057021 

3D Measure tools do not 
work consistently 

The 3D measuring tools usually work the first time they are started in an ERDAS IMAGINE 
session, but the tools become inconsistent after you close and reopen the 3D View. It is 
difficult to reproduce consistently, but it seems to happen when you close the 3D View and 
then show the point cloud in 3D again (without removing the point cloud data from the 2D 
View). The first time the point cloud data is shown in the 3D View the 3D measure tools work, 
but after closing and reopening the 3D View the 3D measure tools to not respond 
 
To reproduce the problem: 
 

1. Display point cloud file “1815.las” in 2D View. 
2. Display point cloud in 3D. 
3. Click inside 3D View to ensure that view is selected. 
4. Turn on 3D measurement tool (Measure Point) and click in 3D View to measure a 

point…success! 
5. Without doing anything else, close the 3D View. 
6. Display point cloud in 3D again. 
7. Click inside 3D View to ensure that view is selected. 
8. Turn on 3D measurement tool (Measure Point) …nothing happens. 

00069944 Control points crashes 
trying to save camera 
.gms 

This issue is present in ERDAS IMAGINE 2020 (build 1366) 64-bit, 32-bit version works fine 
as well as ERDAS IMAGINE 2018 64-bit/32-bit. 
 
To reproduce with attached data: 

1. Open ps_napp.img in 2D View 
2. Run Panchromatic tab>Transform & Orthocorrect group > Control Points 
3. Select Camera geometric model 
4. In GCP tool pick GCP file and select ps_camera.gcc 
5. Within Camera Model Properties windows, select ps_dem.img as an Elevation 

Source. Click Yes to All for the notification message. 
6. Click Save As to save geometric model. Provide filename and click OK. Multipoint 

Geometric Correction tool will crash. 

00061258 “Make TOC” program for 
RPF data gives ERROR: 
Invalid index or value 
expression! 

This has been reported by a customer in Canada 
 
Make sure there are no existing A.TOC files in \\alpha\Teamspace\args\Ian\RPF_Ian 
Call Manage Data tab > NITF/NSIF group > Make RPF ToC 
Specify a file in the directory \\alpha\Teamspace\args\Ian\RPF_Ian 
Click Make TOC 
 
Error 
Invalid index or value expression 
[OK] [OK to All] 
 
...but if you OK that dialog the A.TOC seems to be created. 
Customer reports that this started happening at v16.5.1. 
 
12/03/20 13:18:15 eWkspace_64(40824): Loading [makerpftoc.eml]... 
12/03/20 13:19:51 SessionMgr(32192): ERROR: #5083 from eeci_SingleStepCode 
12/03/20 13:19:51 SessionMgr(32192): ERROR: Problem occurred while executing script 
from C:/Program Files/Hexagon/ERDAS IMAGINE 2020/scripts/makerpftoc.eml at line 71 
12/03/20 13:19:51 SessionMgr(32192): ERROR: #4 from eeci_PopSetArray 
12/03/20 13:19:51 SessionMgr(32192): ERROR: Invalid index or value expression! 
12/03/20 13:19:51 eWkspace_64(40824): Writing File c:/temp/attd40824 
12/03/20 13:19:51 C:/Program Files/Hexagon/ERDAS IMAGINE 
2020/bin/x64URelease/maketoc.exe c:/temp/attd40824 
//alpha/teamspace/args/ian/rpf_ian/a.toc 1 
12/03/20 13:19:51 eWkspace_64(40824): Unloading [makerpftoc.eml]... 
12/03/20 13:20:07 SessionMgr(32192): maketoc.exe exited normally. 
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00022515 Surface Difference 
produces unexpected 
results in elevation 
difference statistics when 
Ignore Value and Skip is 
in use 

If you run Surface Difference using the default preference for Image File (General) 
Continuous Statistics Coverage percent = 0.0. The resulting report file and image statistics 
are invalid. If the default is changed to Continuous Statistics Coverage percent = 100.0 the 
expected report file and image statistics are correct. In both cases, the raster difference 
image from the test model is correct . 
 
In the test case, the REFERENCE and TEST raster inputs are copies of the same raster, 
meaning zero difference is expected to be reflected in the report results. 
 
Continuous Statistics Coverage percent = 0.0 
Minimum difference = -24575.25 
Maximum difference = 0 
Mean of difference = -5.840242359086706 
Std Deviation of difference = 378.796596183834 
Median of difference = -0.7499771118164063 
Mode of difference = -0.7499771118164063 
LE90 = 0.7499771118164063 
 
Continuous Statistics Coverage percent = 100.0 
Minimum difference = 0 
Maximum difference = 0 
Mean of difference = 0 
Std Deviation of difference = 0 
Median of difference = 0 
Mode of difference = 0 

00013124  MosaicPro Sort Images 
affects polygon holes 

MosaicPro may get a seamline polygon hole (missing a whole single aerial image), 
depending on which direction you Sort Images according to Image Name, before redoing 
Most Nadir Seamlines.  
 
Note that when you sort images descending and then generate seams, I don't see the island 
polygons. 

00040917 Grayscale TIFF output 
from MosaicPro has 
TIFF Tag for 
PhotometricInterpretation 
set to RGB 

When outputting single-band grayscale TIFF data from MosaicPro 2020 the output TIFF data 
has its TIFF tag value for PhotometricInterpretation set to “RGB”. It should be set to “Min 
Value is Black”. ERDAS IMAGINE 2018 sets this TIFF tag value to “Min Value is Black”. 
 
To reproduce the problem: 
 

1. Start MosaicPro 2020. 
2. Add the image “vers2018_n6212a.tif”. 
3. Run the mosaic process outputting to TIFF format. 

00060262 MosaicPro output shows 
seam gap between 
overlapping images 

MosaicPro writes a 1-pixel seam gap (value 0) between images that have overlapping 
borders. This gap is not seen in ERDAS IMAGINE 2018 when using the same MosaicPro 
options.  

00058430 Weighted seamlines 
crash MosaicPro in 
ERDAS IMAGINE 2020 

Replicated crash using a dataset with 220+ ortho images. 
 
It looks like it is calculating seamlines for each image, but when it gets to Generating 
Seamlines, the application will crash.  
 
"Cutline refine error. No next vertex found for Intersect " error messages are observed in the 
session log.  
 
But with the same dataset version 2018 works fine. 

00056559 MosaicPro will not stitch 
adjacent tiles together for 
some images 

Two adjacent side by side tiles can be displayed in the viewer. After mosaicking the two 
images together using MosaicPro, only one image is written in the mosaic output. 
 
The output image extent window is written for both images, but the output only contains pixel 
values from one image. 
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00060084, 
00054862 

Point Cloud Metadata 
tool crashes when 
assigning projection 
information to LAS file 

The Point Cloud Metadata tool crashes when attempting to assign projection information to a 
LAS file. 
 

1. Start the Point Cloud Metadata tool and open the attached file “no_pro.las”. 
2. Click on the Edit menu and select Add/Change Projection. 
3. In the Projection Chooser set the projection to UTM GRS 1980 NAD83 North, UTM 

Zone 18 and click OK. 
4. The Point Cloud Metadata tool crashes and the projection information is not added 

to the LAS file. 
 
The ERDAS IMAGINE Session log reports “pointcloudinfo.exe exited with status -
1073740791.” 

00060084 Point Cloud Tools > 
Commands: Options to 
set the Elevation Info is 
not operational in 64-bit 
version 

This issue is seen in ERDAS IMAGINE 2020 64-bit.  
 
To Reproduce: 

1. Run ERDAS IMAGINE 2020 64-bit > Terrain tab > Point Cloud Tools > Commands 
2. Select .las file provided 
3. Activate Add/Change Elevation Information and click Options... 

00054761 Point cloud data does 
not display with 
OpenStreetMap 
basemap 

When displaying point cloud data over the OpenStreetMap basemap in a 2D View the point 
cloud data disappears and only a red boundary box is displayed. 
 
Steps to reproduce the problem: 
 

1. Start ERDAS IMAGINE 2020 64-bit  
2. Display the point cloud file provided in a 2D View. 
3. Display the OpenStreetMap basemap in the same 2D View. The point cloud layer 

is no longer displayed, but its boundary is defined by a red box. 

00054761 Point cloud data 
displayed over 
OpenStreetMap 
basemap crashes 
ERDAS IMAGINE 

RDAS IMAGINE 2020 64-bit will crash after displaying point cloud data over the 
OpenStreetMap basemap and then panning and zooming in the 2D View. 
 
Steps to reproduce the problem: 
 

1. Start ERDAS IMAGINE 2020 64-bit  
2. Display the point cloud file provided in a 2D View. 
3. Display the OpenStreetMap basemap in the same 2D View. The point cloud layer 

is no longer displayed, but its boundary is defined by a red box. 
4. Close the point cloud layer by right-clicking on its name in the Contents panel and 

selecting Remove Layer. 
5. Pan and zoom a little bit in the 2D View with OpenStreetMap basemap still 

displayed. 

00043191 HPF Pansharpening 
process gives error 
message: "efio_fread 
failed" if the 
Panchromatic data size 
is bigger than 4GB 
created by GDAL 

Customer reported that HPF Pansharpenning doesn’t work. While performing HPF 
Pansharpenning , ERDAS IMAGINE gives the following error messages: "efio_fread failed". 
The customer found that similar panchromatic image size less than 4GB, ERDAS IMAGINE 
completes the process and results are good. 
 
Error message : "efio_fread failed" during the HPF PanSharpening process. 
 
BigTIFF files (> 4GB) created by packages other than GDAL appeared to work fine. 

00046034 Warptool is unable to 
resample 271 band 
Headwall Hyperspectral 
data in ENVI hdr format 
or as the imported *img 
format 

Customer reported that Warptool is unable to resample 271 band Headwall Hyperspectral 
data. 
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00062719 Warptool Camera model 
aborts when resample 
process is run with 
specific data 

To recreate: 
 

1. Display input raster ‘foto_input.img’. 
2. Panchromatic tab > Transform group > Control Points 
3. Select Saved Model > Camera model, then OK 
4. Load Geometric Model ‘camera_es5.gms’ 
5. Substitute local file ‘dem.img’. 
6. GCP Tool opens > select GCP File (.gcc) , then OK > from File Chooser select 

‘coordinate_reference.gcc’, then OK 
7. Select Close 
8. Select Solve Geometric icon 
9. Select Resample > enter output filename 
10. Then select OK to run 

 
Warptool crashes with error: 
 
14/04/20 16:31:33 SessionMgr(27236): warptool.exe exited with status -1073741819. 
 
Same process using same steps works in ERDAS IMAGINE 2018. 

00039282 Export CADRG will not 
write files into folder 
name containing the 
character ‘ö’ 

Export CADRG fails to write RFP frames to a folder name containing special character ö. 
Problem is not seen with other special characters å and ä. 

00061258 Make RPF TOC fails 
when attempting to 
create TOC file to 
mapped network drive 

The Make RPF TOC fails when attempting to create TOC file across network. 
 

1. Map network drive W: pointing to a UNC network location. 
2. Make sure there are no existing A.TOC files in W:\CAN_VFR_250K. 
3. Open the Make RPF TOC tool (ERDAS IMAGINE 2020 > Manage Data tab > 

NITF/NSIF group > Make RPF TOC). 
4. Select the RPF directory W:\CAN_VFR_250K as the location to create the A.TOC 

file. 
5. Click the Make TOC button. 
6. The error message “Invalid index or value expression” pops up (see linked bug), 

but if you click OK the process continues. 
7. The Process List reports the status “Parsing Attribute File” and the progress meter 

sits at 20% until it eventually fails. 

00050423, 
00041391, 
00050423  

Better DSM results 
needed from Semi-
Global Matching (SGM) 

Elevation data extracted from stereo imagery pairs using SGM was not as good as expected. 

00068281, 
00066818 

3D ASCII file causes 
error when adding DTM 
to Terrain Prep Tool 

A 3D ASCII file (*.xyz) that does not have negative X and Y coordinates will cause error 
when loading it into the Terrain Prep Tool. The error is: 
 
 Incorrect object type when accessing key "URL" 
 
The same 3D ASCII files that cause this error in ERDAS IMAGINE 2020 can be loaded into 
ERDAS IMAGINE 2018’s Terrain Prep Tool without any problems. 
 
Steps to reproduce the problem: 
 

1. Start the Terrain Prep Tool. 
2. Click the button for “Add DTM files to the list”. 
3. Set the file type to “3D ASCII (*.xyz)”. 
4. Select the provided file “3d_point_data.xyz” and the errors display 

00016717 ECRG exporter does not 
write EPF frames with 
some data (thematic not 
a valid input) 

The ECGR exporter was allowing non-RGB imagery to be input and spend time processing it 
even though it is not a valid input. 
 
The exporter needs enhancing to disallow inputting non-RGB imagery. 
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IMAGINE Objective 

Issue ID Summary – IMAGINE 
Objective 

Description / How to Reproduce 

00066419 Typo in Association:Shadow 
VOP help documentation 

There is a minor typo in the Help documentation for the Vector Object Processor 
Association:Shadow. Towards the bottom of the page it says: 
 
This cue metric is useful for classifying objects that case visible shadows such as 
buildings, trees, targets, etc. 
 
It should say “cast” instead of “case.” 

00062294 IMAGINE Objective crashes 
when adding Raster Pixel 
Processor queues to project 
on system without Java 
installed 

IMAGINE Objective crashes when adding raster pixel processor queues to Objective 
project. 
 
To recreate 
 

1. Launch IMAGINE Objective 
2. Dismiss the Attention warning dialogues indicating java Runtime Environment 

is missing 
3. Create new Project and new Feature Model 
4. Add New Variable of Raster type (residential.img), then click OK 
5. Expand Project treeview and select Raster Pixel Processor 
6. In the Properties panel > Properties tab, select Identity from the Pixel ques 

list > then click the Add button + the properties tab. 
  
You should see the crash 
 
0/10/19 15:03:42 fe_workstation(5008): Exiting all editors 
30/10/19 15:03:42 fe_workstation(5008): Opened layer 
c:/data/temp/residential.img(:Layer_1) 
30/10/19 15:04:11 SessionMgr(4356): fe_workstation.exe exited with status -
1073741819. 
 
Crash does not occur after installing Java Runtime environment v8u202. 

00009668 sentinel2.dll error when 
running IMAGINE Objective 
Vector Cleanup Operator 

When running an IMAGINE Objective project with just a Vector Cleanup Operator it 
caused an error stating “Could not load DLL  
D:\program_files\IMAGINE2016\usr\lib\x64URelease\RasterFormats\sentinel2.dll: 
Unknown error code – 127”.  
 
The process runs to completion and the output file is created successfully. Error 
message about the sentinel2.dll seems unrelated to the actual issue. 

00012292 Dilate Raster Object 
Operator does not dilate 
complete image coverage 

Dilate Raster Object Operator does not dilate the total image area for all classes. In the 
specific example project, the dilation does not extend through the total image for a 
specific class. Other classes appear to be dilated through the complete image extent. 

00009384 Different results for output 
based on simple change in 
manner of processing 

If the user processes Objective by doing half the processing, and then completes the 
processing from the point they first stopped, the resulting output is different from the 
output if they just let the entire process run. The resulting polygons are different. There 
are polygons missing. 
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IMAGINE Photogrammetry 

Issue ID Summary – IMAGINE 
Photogrammetry 

Description / How to Reproduce 

00046100 Import tool imports INPHO 
project with wrong flying 
height 

When importing Inpho project to block file; at project import default unit is meters, and 
when you enter units as US Survey Feet importer makes a conversion from meters to 
US Survey feet which it shouldn’t because project is triangulated in US Survey feet. 
Defining the INPHO projection units should not result in unit conversion. 

00067721 PYRX pyramids not 
recognized as existent in 
IMAGINE Photogrammetry 

When computing PYRX pyramids for use within IMAGINE Photogrammetry, they are 
not recognized as existent (green color) in the column "Pyr". However, the ViewPlex of 
the Terrain Editor and PRO600 is apparently able to work with the PYRX pyramids.  

00058613 APM Crashing with ORIMA 
2020 

APM fails with projects containing 1000 to 3000 images or more. 

00041391 XPro SGM has problems 
with new Vexcel sensor, 
Mark III 

Several problems observed with new camera from Vexcel, the Mark III. This new sensor 
has an extreme high resolution, which allows the aerial photogrammetric companies to 
fly much higher than before and still get the same ground-pixel resolution.  
  
The camera generates such high resolution images, that AutoDTM has problems 
processing them. XPro requires to generate new TIF images, but these are not 
recognized afterwards.  
  
These issues are addressed by using IMAGINE DSM Extractor. 

00050423 DSM generated by 
IMAGINE Photogrammetry 
against DSM generated by 
another software vendor 

Tridicon SGM was producing results which were not comparable in quality to some 
other software vendors using WorldView-3 imagery.  
  
These issues are addressed by using IMAGINE DSM Extractor. 
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IMAGINE Professional 

Issue ID Summary – IMAGINE 
Professional 

Description / How to Reproduce 

00070492, 
00070356, 
00067255 , 
00062666, 
00062056, 
00061236, 
00061293 

Accuracy Assessment 
tool truncates reference 
values 

When manually entering values in the Reference column of the Accuracy Assessment tool 
the digit in the ones decimal place gets removed. For example, entering a value between 0-
9 becomes 0, while 15 becomes 1, 25 becomes 2, 255 becomes 25, etc. 
 

1. Start the Accuracy Assessment tool (Raster tab > Classification group > 
Supervised > Accuracy Assessment) 

2. Open the attached raster image eldoatm_class25.img (File menu > Open). 
3. Create random points (Edit menu > Create/Add Random Points) 
4. Number of Points: 10 
5. Distribution Parameters: Random 
6. Show the class values (Edit menu > Show Class Values). 
7. For row 1 enter value 1 in Reference column. It becomes 0. 
8. For row 2 enter value 22 in the Reference column. It becomes 2. 

00049855 Area Frame Sampling 
Project Manager 
corrupts image paths of 
saved projects 

Area Frame Sampling Project Manager corrupts the image paths of saved projects. 
Customer reports this works in ERDAS IMAGINE 2011. Problem is seen in ERDAS 
IMAGINE 2016 and ERDAS IMAGINE 2018. 
 
Image file paths are added to the Area Frame Sampling project during construction. These 
pathnames are corrupted after saving and reopening the project. The path of the project file 
(.spf) is inserted before the path of the project images. 
 
Example image file path and name while building the project: 
 
C:\temp\lnsoils.img 
 
Example image file path and name after saving and reopening the project: 
 
C:\Data\SFDC\00049855_frame_sampling\C:\temp\lnsoils.img 
 
The only workaround is to reinsert the images into the project after reopening the project. 
Basically, rebuilding the project. 

00067397 Detect Objects Using 
Deep Learning 
producing shifted output 
(when coordinates go 
down by Y axis from 
origin?) 

Working with the material from this demo: 
https://community.hexagongeospatial.com/t5/Spatial-Modeler-Tutorials/Mapping-Oil-Palms-
using-Deep-Learning-Object-Detection/ta-p/38259 If 
BuildingFootprints_SpatialJoin_Damage_NE_Subset is run against the training tile 
BuildingFootprints_SpatialJoin_Damage_NE_Subset the shapefile output does not properly 
overlay on the raster input.  
 
The produced shapefile output will be shifted, so that upper left Y from the image becomes 
lower right in shapefile. 

00068354 Help references the 'ML 
Model' menu name used 
in the 2018 Machine 
Layout interface 

Machine Layout model pull down menu name was changed to Machine Intellect in ERDAS 
IMAGINE 2020. Machine Layout Online documentation references the ERDAS IMAGINE 
2018 interface name ML Model. There are multiple references of ML Model listed in the 
Online documentation. 
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Spatial Modeler  

Issue ID Summary – Spatial 
Modeler 

Description / How to Reproduce 

00046042 Union Features states it 
accepts Lists (of 
Features), but it does not 

The Help for Union Features states the following: 
 

 
 
However, if you try to feed a List of Features to the FeaturesIn1 port it will fail with the 
following message: 
 
Spatial Model failed in Union Features 2. The error was 
"HexagonGeospatial::FeatureAnalysis::UnionFeaturesOperator::OnExecute 
failed 
No input features found.". 

00054184 Classify Using Machine 
Learning workflow 
generates no classes with 
Pseudo Mercator data 

Classify Using Machine Learning workflow will generate empty classes (i.e. min=0, 
max=0) in the classified output raster if the projection of the training input raster is 
registered to projection: Pseudo Mercator, Spheroid/Datum: WGS84, EPSG Code: 
3857. 
 
Classify Machine Using Machine Learning workflow will generate expected number of 
classes (i.e. min=0, max=4) in the classified output raster if the projection of the training 
input raster is registered to another projection: UTM Zone 36, Spheroid/Datum: WGS84, 
EPSG Code: 32636). 
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00061099 Classify Using Machine 
Learning fails with error: 
Buffer dtype mismatch, 
expected 'SIZE_t' but got 
'long' 

To reproduce run the classify_using_machine_learning.gmdx model with associated 
subset_1.img input image and trainingwaternietwater.miz. 
 
Initially partner has reported that this issue can be reproduced when running the process 
only in Batch mode, but it can be replicated on some computers via Run. 
 
It fails with the below error in ERDAS IMAGINE 2020 32-bit/64-bit and in ERDAS 
IMAGINE 2018 64-bit: 
 
10/03/20 15:54:42 SessionMgr(14920): Connection success for the external process 
'eWkspace_64' 
10/03/20 15:57:54 SessionMgr(14920): Executing spatial model: 
d:/0sfdc/83machinelearning/classify_using_machine_learning.gmdx 
10/03/20 16:08:19 SessionMgr(14920): Running command line: C:/Program 
Files/Hexagon/ERDAS IMAGINE 2020/bin/x64URelease/mlpywrapper.exe "C:/Program 
Files/Hexagon/ERDAS IMAGINE 
2020/etc/MachineLearning/Operators/randomforestpredictraster.py" "d:/temp/SM-2 
7a7-d52f-3c06-3c41-002344/mlpy_jsoninput_4513b634-8662-4c89-bc1a-
cd0887c4593d.Json" "d:/temp/SM-27a7-d52f-3c06-3c41-
002344/mlpy_jsonoutput_ef7ccef4-a66b-4877-ad61-db6dcd8b95dd.Json" 
\\.\pipe\6786d301-5f4e-45f4-be7c-8942640df7fa 
10/03/20 16:08:47 SessionMgr(14920): Error occured while running 
randomforestpredictraster 
10/03/20 16:08:47 SessionMgr(14920): Buffer dtype mismatch, expected 'SIZE_t' but 
got 'long' 
10/03/20 16:08:47 SessionMgr(14920): D:\TEMP_MEI160602\sklearn\base.py:315: 
UserWarning: Trying to unpickle estimator LabelEncoder from version 0.18.1 when 
using version 0.18.2. This might lead to breaking code or invalid results. Use at your 
own risk. 
 
10/03/20 16:08:47 SessionMgr(14920): D:\TEMP_MEI160602\sklearn\base.py:315: 
UserWarning: Trying to unpickle estimator DecisionTreeClassifier from version 0.18.1 
when using version 0.18.2. This might lead to breaking code or invalid results. Use at 
your 
own risk. 
10/03/20 16:08:55 SessionMgr(14920): Could not understand JSON for type: 
IMAGINE.File 
10/03/20 16:08:55 SessionMgr(14920): Spatial model execution failed. 
10/03/20 16:19:25 SessionMgr(14920): external process exited with status 1. 
 
Only ERDAS IMAGINE 2018 32-bit executes this model successfully. Have placed 
Replace NoData With operator due to the defined limitation for Classify Using Machine 
Learning operator. However, ERDAS IMAGINE 2018 32-bit successfully executes this 
model even with original data that has NoData pixels. 

00070615, 
00070399, 
00069009, 
00060855, 
00056785 

Changing input file in 
legacy model (.gmd) does 
not correctly update the 
function definition 

If you change one of the input files in a model it does not update the input file in the 
function definition correctly. Instead, it attaches the new input file name to the original 
input file name. For example, if you have a model which adds two input raster files 
together the initial function definition looks like “$n1_input_one + $n2_input_two”, but if 
you go back and change the input file from “input_two.img” to “input_three.img” and 
check the function definition again it now looks like “$n1_input_one + 
$n2_input_twon2_input_three”. It does not remove the original input file name, and this 
causes the model to crash.  
 
This only occurs in the 64-bit version of ERDAS IMAGINE 2020 Update 1. The problem 
does not happen in the 32-bit version of ERDAS IMAGINE 2020 Update 1 or in ERDAS 
IMAGINE 2018. 
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00059887 ModelMaker: Function 
Definition doesn't properly 
update predefined band 
selection with values from 
new image 

This works properly in ERDAS IMAGINE 2018. To reproduce issue in ERDAS IMAGINE 
16.6 build 1366: 
 
1. Open attached cb1.gmd in Model Maker 
2. Double-click on Function, which will be shown as: 
 
EITHER 10000 IF ( ($n1_w10_20181120(7)==-10000) OR ($n1_w10_20181120(8)==-
10000) OR ($n1_w10_20181120(9)==-10000 )) OR 
($n1_w10_20181120(8)$n1_w10_20181120(7) 
$n1_w10_20181120(9))0.001$n1_w10_20181120(7)*0.001(702-667)/(742-667) 
OTHERWISE 
 
3. Close Function Definition. Double-click on Input Raster and pick input.img file 
(attached). 
Function will be updated to an invalid one: 
EITHER 10000 IF ( ($n1_w10_20181120(7)==-n1_input(7)==-10000) OR 
($n1_w10_20181120(8)n1_input(8)==-10000) OR 
($n1_w10_20181120(9)n1_input(9)==-10000 )) OR 
($n1_w10_20181120(8)$n1_input(8)$n1_w1n1_input(7) -
$n1_w10n1_input(9))0.001$n1_w10_20181n1_input(7)*0.001(702-667)/(742-667) 
OTHERWISE 
 
In ERDAS IMAGINE 2018 it properly changes to new values: 
 
EITHER 10000 IF ( ($n1_input(7)==-10000) OR ($n1_input(8)==-10000) OR 
($n1_input(9)==-10000 )) OR ($n1_input(8)$n1_input(7) 
$n1_input(9))0.001$n1_input(7)*0.001(702-667)/(742-667) OTHERWISE 

00060343 Problems reading stats 
should not cause Raster 
Input to fail 

IMG format files downloaded from USGS website have StatisticsParameters that are 
incorrectly written which cause RasterInput to fail. This should be corrected. 

00058591 Join Features operator: 
Select Attribute doesn't 
provide full list of 
attributes from Join 
Features result 

To reproduce: 
 

1. Open provided model 
2. Double-click on Attribute Name port of Select Attribute operator. Notice that 

Corine_R attribute is not present 
3. Double-click on Attribute Names of Select Attributes operator. Notice that 

Corine_R attribute is there 
4. Manually type in the Corine_R attribute to the Attribute Name port of Select 

Attribute operator. Right-click on Select Attribute operator and pick Run Just 
This. Notice that it will output this attribute 

00058591 Join Features operator: 
Doesn't output attributes 
from features with no 
geometry 

Run original attribute_join_original.gmdx model with provided data. It will output 
attributes from the Left features only without matching attributes from Right. 

00068887 Shapefile created with 
GDAL - Projection not 
recognized in Spatial 
Modeler 

Error message that gets displayed in Spatial Model Editor is: “Dimensionality of CRS 
cannot be determined”.  
 
Session log adds: Failed to recognize Authority Code with Authority "PRJ" and Authority 
Code "D:/tmp/kws/problems_imagine2020u1/computed/searchArea.prj" 
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00069509 Spatial Model fails when 
reprojecting from 
EPSG:4326 to 
EPSG:32632 

When using a spatial model to reproject a global DEM from EPSG:4326 to EPSG:32632 
and subsetting the output to match the extent of a smaller reference image the process 
fails. E.g. when attempting to subset and reproject from a global DEM in EPSG:4326 to 
an area matching a reference image in EPSG:32632. 
 
Spatial Model Editor reports the following messages: 
 
Raster Input: Pixel Block Request failed: EFGA_DERIVEPOLYCOEFS failed 
Raster Output: Unknown exception. (`anonymous-
namespace'::AsyncReadImpl::get_Result failed 
erdas::sblegacylib::PortGriddedDataSource::Read failed 
 
Session log shows these errors: 
 
1/10/20 13:20:12 SessionMgr(24476): Executing spatial model: 
d:/tickets/00069509/reproject_resample_raster.gmdx 
01/10/20 13:20:12 SessionMgr(24476): Unable to extract EPSG code from CRS with 
title 'ps1'; ignored 
01/10/20 13:20:12 SessionMgr(24476): Unable to extract EPSG code from CRS with 
title 'g1674'; ignored 
01/10/20 13:20:14 SessionMgr(24476): ERROR: #950 from 
eirf::ImageWarper::Impl::GeometricTransMagGet 
01/10/20 13:20:14 SessionMgr(24476): ERROR: EFGA_DERIVEPOLYCOEFS failed 
01/10/20 13:20:14 SessionMgr(24476): ERROR: #4 from EFGA_DERIVEPOLYCOEFS 
01/10/20 13:20:14 SessionMgr(24476): ERROR: EFGA_SOLVELINEAREQS failed 
01/10/20 13:20:14 SessionMgr(24476): ERROR: #4 from EFGA_SOLVELINEAREQS 
01/10/20 13:20:14 SessionMgr(24476): ERROR: egda_MatrixDivide failed 
01/10/20 13:20:14 SessionMgr(24476): ERROR: #6 from egda_MatrixDivide 
01/10/20 13:20:14 SessionMgr(24476): ERROR: egda_MatrixDivideF64 failed 
01/10/20 13:20:14 SessionMgr(24476): ERROR: #2 from egda_MatrixDivideF64 
01/10/20 13:20:14 SessionMgr(24476): ERROR: egda_MatrixLUDecomposition failed 
01/10/20 13:20:14 SessionMgr(24476): ERROR: #7 from egda_MatrixLUDecomposition 
01/10/20 13:20:14 SessionMgr(24476): ERROR: egda_MatrixLUDecompositionF64 
failed 
01/10/20 13:20:14 SessionMgr(24476): ERROR: #1 from 
egda_MatrixLUDecompositionF64 

00045305 Creating submodels may 
displace annotation and 
operator layout 

Creating submodels from relatively complex models displaces the layout of text 
annotation and operators in the model. 
 
Product Manager observed similar model behavior when creating submodels and 
reports the amount of shifting correlates with the complexity of the model. The more 
complex the model, the greater the displacement of operators and text. 

00052363 Running a model from the 
Ribbon will fail when 
using Map Boundary port 

Running a model from the ribbon (e.g. Launch Spatial Model, My Models) will fail if the 
Map Boundary port coordinates are defined using the Inquire Box. Defining the Map 
Boundary by manual keyboard entry will work. Same model runs successfully using the 
Inquire Box if it’s run from the Spatial Model Editor window. 
 
Model errors: 
 
24/09/19 10:20:50 Spatial Model failed in Raster Input.  The error was 
"erdas::sb_raster::RasterInput::ResolveBBox failed 
24/09/19 10:20:50 Bounds do not intersect image". 
24/09/19 10:20:50 SessionMgr(34428): Spatial model failed. 
24/09/19 10:20:50 
24/09/19 10:20:51 SessionMgr(34428): smprocess.exe exited with status 1. 
 
Running the model from Spatial Model Editor using same model parameters from above 
will run successfully. 

00050531 Schema Remodeler 
"Rename Attributes" is 
dropping coordinate 
system ID resulting in 
error 

Schema Remodeler "Rename Attributes" is dropping coordinate system ID resulting in 
the following error. 
 
System Model failed in Union Features. The error was "The input geometry field 
'Geometry' does not have a valid CoordinateReferenceSystemld. The input geometry 
cannot be transformed to target CRS without a known source CRS" 
 
It appears the "Rename Attributes" operator is dropping the coordinate system ID. 
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00064086, 
00048695 

Spatial Model changes 
datum of input feature 
data 

When processing input feature data that are projected to Lambert Conformal Conic with 
the datum “MGI AT (EPSG: 1618)”, the output features and raster data have a different 
datum which causes a shift of approximately 300 meters in the X-direction. The output 
features data are assigned the datum “MGI”. The output raster data is assigned the 
datum “Militar-Geographische Insttut [To WGS 84 8]”. 

00051840 Encode Height to Vertex 
Z spatial model is giving Z 
values all 0 with ESRI asc 
input file 

Customer reported that they have created a spatial model on the basis of the following 
Encode Height to Vertex Z spatial model: 
 
https://community.hexagongeospatial.com/t5/Spatial-Modeler-Tutorials/Encode-Height-
to-Vertex-Z/ta-p/26083 
 
If the customer runs the model with asc file as input, the model successfully ran and 
generated output shapefile. However, the geometry 'z' were all 0. 
Running the same model with a tif raster DEM, the geometry 'z' gets populated. 

00060388 Error in Spatial Modeler 
with GeoPackage dataset 
(containing features) 

To Reproduce: 
 

1. Run Toolbox tab > Spatial Model Editor 
2. Add Features Input operator 
3. Double-click on Filename port 
4. Pick GeoPackage Features Proxy (*.gfb) and click Connect. 
5. In the GeoPackage Data Source window browse for data.gpkg (provided) and 

provide the name 
6. When you will select this data in Database Connections section, the error 

shows up saying "unrecognized token: "2019xxxx" 
 
This data can be successfully opened in QGIS. However, other GIS applications throw 
the same error. 

00058909 Missing "Verify Save on 
Close" dialogue when 
closing the Spatial Model 
Editor after editing text 
annotations 

To reproduce: 
 
1. Open provided test.gmdx 
2. Edit the annotation text. 
3. Close Spatial Model Editor. It will not offer to save edits and close the Editor window. 
As a result - no edits saved. 

00065622, 
00058966 

Classify Ground operator 
may crash Spatial 
Modeler 

A customer reports that Spatial Modeler is crashing when running a model containing 
the Classify Ground operator. They provided a dump file that indicates the cause is heap 
corruption during parallel processing of points. 

00063198 Apply Mask fails with 
binary data unless you 
pick the class via "Eq" 
operator 

If input.img is a u1 binary image, you should not require the Eq operator in a Spatial 
Model like this, which uses the Apply Mask operator: 
 

 

00070549 Spatial Modeler crashes 
when running with the 
Iterator operator 

Spatial Modeler crashes when working with the Iterator operator with a sub-model that 
copies files from one folder to another if the model: 
 

1. Is run repeatedly (more than once) 
2. Clear Results is selected 
3. Try to delete any operator using the Delete key 

  
This problem is not observed running IMAGINE 2018 b1265 

https://community.hexagongeospatial.com/t5/Spatial-Modeler-Tutorials/Encode-Height-to-Vertex-Z/ta-p/26083
https://community.hexagongeospatial.com/t5/Spatial-Modeler-Tutorials/Encode-Height-to-Vertex-Z/ta-p/26083
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00066469 Apply AOI operator fails 
unexpectedly with some 
AOIs 

Apply AOI operator fails with a customer supplied AOI (test.aoi). This same AOI works 
with other operators (e.g. Raster Input) and ERDAS IMAGINE programs (e.g. Subset). 
An AOI (hgd_1.aoi) that was manually screen digitized on top of the test image, works in 
the model. 
 
Session Log: 
 
16/07/20 16:45:45 SessionMgr(54660): Executing spatial model: //alpha/jira_data/im-
54785/apply_aoi.gmdx 
16/07/20 16:45:46 SessionMgr(54660): 
HexGeo::SpatialModelerRaster::RasterUtils::BoxIntersection failed 
16/07/20 16:45:46 Images do not Intersect. 
16/07/20 16:45:46 SessionMgr(54660): Spatial model execution failed. 

00064752 Operator "Focal Sum" 
crashes Spatial Modeler 
when input data has 
NoData defined 

To reproduce run the focal_sum.gmdx model with provided data. The input data has 
NoData defined. Spatial Modeler will crash. 
 
The rest of Focal functions operate normally with that data, only Focal Sum leads to an 
application crash. 
 
If to replace NoData with valid value (e.g. 0), model will execute successfully. 

00067504 IMAGINE.Directory value 
is not the same across all 
operators (causes Path 
Exists to fail) 

Path Exists operator seems to accept string representation of IMAGINE.Directory object, 
but the value has to be in quotation marks (" ") . 
 
Port Input and Directory Input outputs IMAGINE.Directory value without those, so Path 
Exists fails with a "No appropriate data found on port(Path)." error. 
 
Get Containing Directory also outputs the IMAGINE.Directory, but in quotation marks, so 
Path Exists works, and also works when IMAGINE.Directory is first converted to String. 

00069394 Classify Using Deep 
Learning operator does 
not correctly remember its 
"complete" status for re-
running downstream 
operations 

The provided Spatial Model takes an input NITF / BIIF image and runs a Deep Learning 
classifier to classify tiles that contain clouds. This is then used to estimate cloud cover. 
 
To reproduce the problem: 
 

1. Open the model in a Spatial Model Editor 
2. Start the Session Log 
3. Click Preview 
4. Wait for the deep learning to complete and the preview to show. 
5. Note that the Classify Using Deep Learning operator is checked green. 
6. Now pan to the tail end of the model, select the Report operator, right-click 

and select Run Just This 
7. Normally what you would expect to happen is for just those un-run operators 

to have to run. Anything that's upstream that has already completed should 
not have to be executed again. 

8. But Deep Learning classification starts all over again - you'll need to wait. 
 
As mentioned, only if something upstream of the Classify Using Deep Learning operator 
is modified would you expect anything downstream to be invalidated. In this instance we 
have not done that, so the Report should run in a matter of seconds.  
 

9. Now click Run 
10. Take all the defaults in the dialog again 
11. This should invalidate all the current results and start from scratch. 
12. But the model will fail 
13. That shouldn't happen either. 

 
At this point you need to quit and restart ERDAS IMAGINE otherwise Spatial Modeler 
just isn't going to run correctly. 

00003034 Spatial modeler Vector 
input operator cannot 
process shapefile with "-" 
in path 

The older Vector Input operator would not parse filenames that included the “-“ 
character. The replacement Features Input operator has no such limitations. 
 
Note that this change happened many versions ago but the Issue has only recently been 
marked as Closed.  
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Contact Us 
 

 

https://go.hexagongeospatial.com/contact-us-today  

 

 

 

 

 

 

 

 

About Hexagon 
Hexagon is a global leader in sensor, software, and autonomous solutions. We are putting data to work to 
boost efficiency, productivity, and quality across industrial, manufacturing, infrastructure, safety, and mobility 
applications.  

Our technologies are shaping urban and production ecosystems to become increasingly connected and 
autonomous — ensuring a scalable, sustainable future.  

Hexagon’s Geospatial division creates solutions that deliver a 5D smart digital reality with insight into what 
was, what is, what could be, what should be, and ultimately, what will be. 

Hexagon (Nasdaq Stockholm: HEXA B) has approximately 21,000 employees in 50 countries and net sales of 
approximately 4.4bn USD. Learn more at hexagon.com and follow us @HexagonAB. 

 

  

https://go.hexagongeospatial.com/contact-us-today
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Copyright  
© 2020 Hexagon AB and/or its subsidiaries and affiliates. All rights reserved. Hexagon has registered 
trademarks in many countries throughout the world. Visit the Trademarks Page 
http://www.hexagongeospatial.com/legal/trademarks for information about the countries in which the 
trademarks are registered. See Product Page and Acknowledgments for more information. 

Product Documentation Terms of Use 
PLEASE READ THESE TERMS CAREFULLY BEFORE USING HEXAGON GEOSPATIAL’S 
DOCUMENTATION ("DOCUMENT"). USE OF THIS DOCUMENT INDICATES ACCEPTANCE OF THIS 
AGREEMENT WITHOUT MODIFICATION. IF YOU DO NOT AGREE TO THE TERMS HEREOF ("TERMS"), 
DO NOT USE THIS DOCUMENT. 

Use Of This Document 
All materials in this Document are copyrighted and any unauthorized use may violate worldwide copyright, 
trademark, and other laws. Subject to the terms of this Agreement, Hexagon Geospatial (a Division of 
Intergraph Corporation) and Intergraph’s subsidiaries ("Intergraph") hereby authorize you to reproduce this 
Document solely for your personal, non-commercial use. In consideration of this authorization, you agree to 
retain all copyright and other proprietary notices contained therein. You may not modify the Materials in any 
way or reproduce or publicly display, perform, or distribute or otherwise use them for any public or commercial 
purpose, except as specifically authorized in a separate agreement with Hexagon Geospatial.  

The foregoing authorization specifically excludes content or material bearing a copyright notice or attribution of 
rights of a third party. Except as expressly provided above, nothing contained herein shall be construed as 
conferring by implication, estoppel or otherwise any license or right under any copyright, patent, or trademark 
of Hexagon Geospatial or Intergraph or any third party. 

If you breach any of these Terms, your authorization to use this Document automatically terminates. Upon 
termination, you will immediately destroy any downloaded or printed Materials in your possession or control. 

Disclaimers 
ALL MATERIALS SUPPLIED HEREUNDER ARE PROVIDED "AS IS", WITHOUT WARRANTY OF ANY 
KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-
INFRINGEMENT. Hexagon Geospatial does not warrant that the content of this Document will be error-free, 
that defects will be corrected, or that any Hexagon Geospatial Website or the services that make Materials 
available are free of viruses or other harmful components. 

Hexagon Geospatial does not warrant the accuracy and completeness of this Document. Hexagon Geospatial 
may make changes to this Document at any time without notice. 

Limitation Of Liability 
IN NO EVENT SHALL HEXAGON GEOSPATIAL BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL OR CONSEQUENTIAL DAMAGES, OR DAMAGES FOR LOSS OF PROFITS, REVENUE, DATA 
OR USE, INCURRED BY YOU OR ANY THIRD PARTY, WHETHER IN AN ACTION IN CONTRACT OR 
TORT, ARISING FROM YOUR ACCESS TO, OR USE OF, THIS DOCUMENT. 

Indemnification 
You agree to defend, indemnify, and hold harmless Hexagon Geospatial, its officers, directors, employees, 
and agents from and against any and all claims, liabilities, damages, losses or expense, including reasonable 
attorneys' fees and costs, arising out of or in any way connected with your access to or use of this Document. 

Use Of Software 
Use of software described in this Document is subject to the terms of the end user license agreement that 
accompanies the software, if any. You may not download or install any software that is accompanied by or 
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includes an end user license agreement unless you have read and accepted the terms of such license 
agreement. Any such software is the copyrighted work of Hexagon Geospatial, Intergraph or its licensors. 
Portions of the user interface copyright 2012- Telerik AD. 

Links To Third Party Websites 
This Document may provide links to third party websites for your convenience and information. Third party 
websites will be governed by their own terms and conditions. Hexagon Geospatial does not endorse 
companies or products to which it links. 

Third party websites are owned and operated by independent parties over which Hexagon Geospatial has no 
control. Hexagon Geospatial shall not have any liability resulting from your use of the third-party website. Any 
link you make to or from the third party website will be at your own risk and any information you share with the 
third party website will be subject to the terms of the third party website, including those relating to 
confidentiality, data privacy, and security. 

Trademarks 
The trademarks, logos, and service marks ("Marks") displayed in this Document are the property of Hexagon 
Geospatial, Intergraph or other third parties. Users are not permitted to use Marks without the prior written 
consent of Hexagon Geospatial, Intergraph or the third party that owns the Mark. "Intergraph" is a registered 
trademark of Intergraph Corporation in the United States and in other countries. Other brands and product 
names are trademarks of their respective owners. 

Find additional trademark information https://www.hexagongeospatial.com/legal/trademarks. 

Procedure For Making Claims Of Copyright Infringement 
Notifications of claimed copyright infringement should be sent to Hexagon Geospatial by mail at the following 
address: Intergraph Corporation, Attn: Intergraph Legal Department, P.O. Box 240000, Huntsville, Alabama 
35824. 

US Government Restricted Right 
Materials are provided with "RESTRICTED RIGHTS." Use, duplication, or disclosure of Materials by the U.S. 
Government is subject to restrictions as set forth in FAR 52.227-14 and DFARS 252.227-7013 et seq. or 
successor provisions thereto. Use of Materials by the Government constitutes acknowledgment of Hexagon 
Geospatial or Intergraph’s proprietary rights therein. 

International Use 
You may not use or export Materials in violation of U.S. export laws and regulations. Hexagon Geospatial 
makes no representation that Materials are appropriate or available for use in every country, and access to 
them from territories where their content is illegal is prohibited. 

Hexagon Geospatial provides access to Hexagon Geospatial international data and, therefore, may contain 
references or cross references to Hexagon Geospatial products, programs and services that are not 
announced in your country. These references do not imply that Hexagon Geospatial intends to announce such 
products, programs, or services in your country. 

The Materials are subject to U.S. export control and economic sanctions laws and regulations and you agree 
to comply strictly with all such laws and regulations. In addition, you represent and warrant that you are not a 
national of, or otherwise located within, a country subject to U.S. economic sanctions (including without 
limitation Iran, Syria, Sudan, Cuba, and North Korea) and that you are not otherwise prohibited from receiving 
or accessing the Materials under U.S. export control and economic sanctions laws and regulations. Hexagon 
Geospatial makes no representation that the Materials are appropriate or available for use in every country, 
and access to them from territories where their content is illegal is prohibited. All rights to use the Materials are 
granted on condition that such rights are forfeited if you fail to comply with the terms of this agreement. 
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Revisions 
Hexagon Geospatial reserves the right to revise these Terms at any time. You are responsible for regularly 
reviewing these Terms. Your continued use of this Document after the effective date of such changes 
constitutes your acceptance of and agreement to such changes. 

Applicable Law 
This Document is created and controlled by Hexagon Geospatial in the State of Alabama. As such, the laws of 
the State of Alabama will govern these Terms, without giving effect to any principles of conflicts of law. You 
hereby irrevocably and unconditionally consent to submit to the exclusive jurisdiction of the United States 
District Court for the Northern District of Alabama, Northeastern Division, or the Circuit Court for Madison 
County, Alabama for any litigation arising out of or relating to use of this Document (and agree not to 
commence any litigation relating thereto except in such courts), waive any objection to the laying of venue of 
any such litigation in such Courts and agree not to plead or claim in any such Courts that such litigation 
brought therein has been brought in an inconvenient forum. Some jurisdictions do not allow the exclusions or 
limitations set forth in these Terms. Such exclusions or limitations shall apply in all jurisdictions to the 
maximum extent allowed by applicable law. 

Questions 
Contact us with any questions regarding these Terms. 

https://www.hexagongeospatial.com/about-us/our-company/contact-us
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